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Class 1 
 

1. The theme: Calculation of metrics of productivity of computer system: speed, efficiency, energy 

costs, Amdahl's law, CPU time. 

2. The goal: developing students' practical skills in determining the performance of a computer 

system and increasing it. 

3. The learning outcomes: after studying this class, the student will: 

- understand what computer system performance is; 

- know what factors impact the performance of a computer system; 

- determine the performance of computer systems using various tools; 

- be able to improve system performance by optimizing the operating system (OS). 

4. Мain questions of the topic: 

1. The performance of a computer system. 

2. Tools to determine the performance of a computer system. 

3. Ways to improve the performance of a computer system. 

Theory 

In computer organization, performance refers to the speed and efficiency at which a computer 

system can execute tasks and process data. A high-performing computer system is one that can 

perform tasks quickly and efficiently, while minimizing the amount of time and resources required 

to complete these tasks. 

There are several factors that can impact the performance of a computer system, including:  

1. Processor speed. The speed of the processor, measured in GHz (gigahertz), determines how 

quickly the computer can execute instructions and process data. 

2. Memory. The amount and speed of the memory, including RAM (random access memory) 

and cache memory, can impact how quickly data can be accessed and processed by the computer. 

3. Storage. The speed and capacity of the storage devices, including hard drives and solid-

state drives (SSDs), can impact the speed at which data can be stored and retrieved.  

4. I/O devices. The speed and efficiency of input/output devices, such as keyboards, mice, 

and displays, can impact the overall performance of the system. 

5. Software optimization. The efficiency of the software running on the system, including 

operating systems and applications, can impact how quickly tasks can be completed. 

Improving the performance of a computer system typically involves optimizing one or more 

of these factors to reduce the time and resources required to complete tasks.  

Computer performance is the amount of work accomplished by a computer system. The word 

performance in computer performance means “How well is the computer doing the work it is 

supposed to do?”. It basically depends on response time, throughput and execution time of a 

computer system.  

Response time is the time from start to completion of a task.  

Throughput is the total amount of work done in a given time.  

CPU execution time is the total time a CPU spends computing on a given task [4].  

One method to achieve high performance is parallelism. Parallelism is the simultaneous 

execution of multiple computations  

In other words, this method involves dividing a task into smaller subtasks that can be completed 

simultaneously. For example, a computer can use multiple cores or processors to work on a single 

task simultaneously, resulting in faster completion of the task. But not all of the process can be 

parallelized. 

Amdahl's law is often used in parallel computing to predict the theoretical speedup when using 

multiple processors. 

Amdahl's law can be formulated in the following way. 

Let it be necessary to solve some computational problem. Let's assume that its algorithm is such 
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that the share of the total amount of calculations α can be obtained only by sequential calculations, 

and the share 1-α can be parallelized between p processors. Then the speedup that can be obtained 

on a computer system of p processors, compared to a single-processor solution, will not exceed 

                                             
 

Table 1 shows data on the speedup of program execution with the share of sequential 

calculations α when using p processors. 

For example, if the share of sequential calculations in the algorithm is 25%, then increasing the 

number of processors to 10 gives a speedup of 3.077 times, and increasing the number of processors 

to 1000 gives a speedup of 3.988 times. 

 

The performance of a computer system can be measured using various tools. Some of them are 

provided by the operating system (Windows), while others require installation or downloading. 

1. Task Manager 

The Windows Task Manager is a powerful tool packed with useful information, from your 

system’s overall resource usage to detailed statistics about each process.  

4 ways to open Task Manager in Windows 10: 

- press CTRL+SHIFT+ESC; 

- press CTRL+ALT+DELETE and select the ‘Task Manager’ option; 

- press Win+X to open the Power Task Menu and select the ‘Task Manager’ option; 

- left-click the taskbar and select ‘Task Manager’. 

 In the Task Manager window, click the Performance tab (Figure 1). The Performance tab 

shows real-time graphs displaying the usage of system resources like CPU, memory, disk, network, 

and GPU. If system has multiple disks, network devices, or GPUs, you can see them all separately. 

The graphs show resource usage over the last 60 seconds. 

 
Figure 1. Task manager, Performance tab 

2. Windows Experience Index 

The Windows Experience Index is a rating system that measures the various parts of your 
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computer that affect performance; they include the processor, RAM, graphics capabilities, and hard 

drive.  

To view a computers Windows Experience Index score in Windows 7 open the Control Panel 

>  System and Security > System. Here you can see the Windows Experience Index and detailed 

information about each part. 

In ОS Windows 8 and 10 you can get The Windows Experience Index using a PowerShell 

command. Type PowerShell in the Windows search bar. Then right-click on Windows PowerShell 

and select Run as administrator (Figure 2).  In the PowerShell window type the command winsat 

formal, then press Enter (Figure 3).  The process takes a few minutes. To view the result, input the 

following command Get-CimInstance Win32_WinSAT in PowerShell window and then press 

Enter. The base Windows Experience Index is listed alongside WinSPRLevel (Figure 4). 

The base score is equal to the lowest of the subscores and it is not an average of the subscores. 

The Windows Experience Index scores have different ranges: they range from 1.0 to 7.9 for Windows 

7, and from 1.0 to 9.9 for Windows 8/10. 

 
Figure 2. Running PowerShell as administrator 

 

 
Figure 3. The system performance assessing in PowerShell 

https://www.lifewire.com/what-is-random-access-memory-ram-2618159
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Figure 4. The system performance assessing result in PowerShell command 

 

3. Windows Resource Monitor 
Windows Resource Monitor is a program in-built into Windows that gives more details about 

the way Windows manages the resources (memory, processor, disk, network) of computer system 

(Figure 5). The information is given in real time. To run the Resource Monitor type Resource Monitor 

in the Windows search bar. 

 

   
Figure 5. The CPU and Memory tabs of the Resource Monitor program in Windows 10 

 

4. Performance Utilities 

To measure the performance of the CPU, special utilities (programs) are used, such as CPU-Z 

(Figure 6) and Intel Extreme Tuning Utility. 

CPU-Z is a freeware system  monitoring application for Microsoft Windows that detects the 

CPU, RAM, motherboard chip-set, and other hardware features of a computer system. The 

information is given in real time. 

5. Benchmarks 

Benchmarks are special programs designed to test computer performance. They can measure the 

performance of the CPU, graphics, hard drive and other components. Some popular benchmarks for 

Windows 10 are 3DMark, Geekbench and CrystalDiskMark. 

Ways to improve Windows 10 performance. 

1. Change power plan 

Microsoft offers three power plans with Windows 10 systems: Power saver mode, High 

performance mode, Balanced power mode. 
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Figure 6. CPU-Z program window 

 

 High performance mode maximizes the computer's performance at the cost of energy use.  

Start > Control Panel > System and Security (or Hardware and Sound) > Power Options. Click 

Create a power plan and select High performance (Figure 7). 

 

 
Figure 7. Chang power plan settings in Windows 10 

 

2. Free up disk space. Removing unnecessary folders and files. 

3. Disable visual effects in the user interface (UI). 

Desktop animations and shadows in the background make the UI look great, but they can consume 

significant CPU and memory. To turn off these features, Start > Control Panel > System and Security 

> System > Advanced system settings > Advanced tab > Settings > Adjust for best performance 

(Figure 8).  
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Figure 8. Disable visual effects in Windows 10 

 

4. Disable startup programs 

To manage Windows 10 startup programs, open the Task Manager  press Ctrl + Shift + Esc and click 

the Start-up tab. Select the programs you don't want to launch automatically and click Disable (Figure 9).  

  

 
Figure 9. Disable startup programs in Windows 10 
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Tasks  

Task 1. 

Using Amdahl's law, determine the speedup of the computer system if: 

a) the share of sequential calculations in the algorithm is 5%, and the number of processors is 10; 

b) the share of sequential calculations in the algorithm is 30%, and the number of processors is 100; 

Task 2. 

a) Evaluate the performance of computer system using the tools of Windows OS (7, 8, 10, etc.) 

- Task Manager; 

- Windows Experience Index;  

- Windows Resource Monitor; 

b) Formulate recommendations for improving performance of a computer system. 

Task 3. 

Download and install the CPU-Z program [5] on your computer and determine the technical 

characteristics of: 

- CPU (model name, process technology, structure and size of cache memory); 

- motherboard (manufacturer, model name, chipset); 

- RAM (type, volume, frequency, connection mode). 

Task 4. 

Improve the performance of your computer system by optimizing the OS: 

- change power plan; 

- disable visual effects; 

- disable unnecessary startup programs. 

Task 5.  

Answer the control questions. 

5. Teaching methods/technology: 

Teaching methods:  

- by external signs of the activity of the teacher and students: story, demonstration, instruction; 

- by source of knowledge: visual (use of technical means - computer, projector), practical 

(performing practical tasks); 

- according to the degree of activity of students’ cognitive activity: problem-based, partially search, 

illustrative, explanatory. 

Teaching technology: 

-    computer training. 

6. Assessment methods/technology: 

Individual student report made in MS Word in electronic format. 

Report Contents 

1. Results of solving task 1 (using the MS Word Formula Editor tool to design formulas and 

calculations) [6]. 

2. Results of completed work (screenshots), description of actions and conclusions for task 2. 

3. Results of analysis of computer technical characteristics using the CPU-Z program (+ screenshots). 

4. Results of improving the performance of a computer system by optimizing the OS (screenshots). 

5. Answers to control questions. 

6. Teaching assessment checklist 

7. References 

1. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the Ministry of 

Education and Science of the Republic of Kazakhstan) 

2. Нурпеисова Т.Б., Кайдаш И.Н. ИКТ. Учебное пособие / Алматы, изд-во Бастау, 2017 

3. Nurpeisova T.B., Kaidash I.N. ICT, Almaty, Bastau, 2017. 241 p.  
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4. https://www.geeksforgeeks.org/computer-organization-performance-of-computer/ 

5. https://www.softportal.com/software-1504-cpu-z.html  

6. https://www.geeksforgeeks.org/how-to-insert-equations-in-a-ms-word-document/ 

8. Control  questions: 

1. What tools can be used to determine the performance of a computer system? 

2. What is the Windows Experience Index and how is it measured? 

3. What parameters of computer elements affect the productivity index? 

3. What is the purpose of the Windows Resource Monitor application? 

4. What are “benchmarks”? Give examples. 

5. What is the purpose of the CPU-Z program? 

6. What hardware characteristics does the CPU-Z program determine? 

7. How to improve the performance of a computer system? 

 

Class 2 
 

1. The theme: Determination of properties of an operating system. Operation with files and 

directories 

2. The goal: developing students' practical skills in determining the properties of the OS and changing 

some of its settings, as well as using the capabilities of the graphical interface and command prompt 

when working with folders and files in Windows OS. 

3. The learning outcomes: after studying this class, the student will: 

- know the functions and types of OS; 

- be able to determine the properties of the Windows 10 OS and change some of its settings 

(language, region, desktop appearance); 

- configure the appearance and properties of folders in Windows 10; 

- be able to perform operations with folders and files using the Windows command prompt; 

- be able to perform operations with folders and files in Windows 10. 

4. Мain questions of the topic: 

1. Types of operating systems. 

2. Types of user interfaces. 

3. Determining the properties of the Windows 10 OS. 

4. Change some OS settings. 

5. Customizing the appearance and properties of folders in Windows 10. 

6. Using the Windows command prompt to work with files and folders. 

7. Working with files and folders in Windows 10. 

Theory 

An operating system (OS) is a set of programs which ensures the interoperability of the 

hardware and software in your computer.  

Some of the functions of Operating system are: 

- manages computer hardware and software resources; 

- provides an interface between user and computer hardware; 

- enables communication between user and computer; 

- performs memory management; 

- manages processes;  

- handles file management; 

- provides security and access control; 

- Enables device and driver management. 

Types of Operating Systems 

1. Single-user, single-task OS – This kind of OS only permits one person to use the computer 

at a time for one job. 

https://www.geeksforgeeks.org/computer-organization-performance-of-computer/
https://www.softportal.com/software-1504-cpu-z.html
https://www.geeksforgeeks.org/how-to-insert-equations-in-a-ms-word-document/
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2. Single-user, multi-task OS – This kind of OS is used on desktop and laptop computers, which 

allow one user to run multiple programmes simultaneously. Examples of single-user multitask 

operating systems are Windows and Apple MacOS. 

3. Multi-user OS – A multi-user OS enables multiple users to work on the same computer at 

different times or simultaneously. 

4. Real Time OS– A computing environment that responds to input within a specific period of 

time is known as a real-time operating system. It controls the computer’s resources so that each 

operation is completed in exactly the same amount of time each time. Real-time operating systems 

include Lynx OS and Windows CE. 

A user interface (UI) refers to the part of an operating system, program, or device that allows a 

user to enter and receive information.  

A text-based user interface (Figure 1) displays text, and its commands are usually typed on a 

command line using a keyboard.  

With a graphical user interface (Figure 2), the functions are carried out by clicking or moving 

buttons, icons and menus by means of a pointing device (mouse). 
 

 
Figure 1. Text-based user interface  

 

 
Figure 2. Graphical user interface 

 

Viewing OS properties can be done in one of the following ways: 

1. This PC icon. 



 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.12 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

Find the icon 
   on the desktop and right-click on it > Properties (Fig. 3). 

 

 
Figure 3. Viewing OS properties  

2. Settings app. 

Start > Settings  > System > About System.  

3. Control panel component. 

Ways to open Control Panel Windows: 

- click Start, type control panel, and select the top result Control Panel app from the list to 

open it; 

- press Win + R keys on the keyboard to open Windows Run dialog, and type control in Run, 

click OK to open Control Panel (Figure 4). 

To view OS properties, in the Control Panel window, select System and Security > System. 

 

 
Figure 4. Launching Control Panel 

 

Managing the Windows 10 OS’s settings. 

Most of the settings on a computer are managed via the operating system’s Control panel, which 

contains the following sections (Figure 5): 
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- System and security; 

- Network and Internet; 

- Hardware and Sound; 

- Programs; 

- User Accounts; 

- Appearance and Personalization; 

- Clock and Region; 

- Ease of Access. 

 

 
Figure 5. Control panel 

 

Let's look at changing some settings of Windows 10. 

1. Changing the Windows 10 OS language. 

Start > Settings > Time and language > Language > Windows display language > Russian 

(Kazakh, English) (Figure. 6). 

 
Figure 6. Changing the Windows 10 OS language 
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2. Changing the region in Windows 10 OS. 

Start > Settings > Time and language > Region > Regional format> Russian (Kazakh, 

English)  (Figure. 7). 

 

 
Figure 7. Changing the region in Windows 10 

 

3. Personalization Settings in Windows 10. 

Personalization is customizing the design of the operating system to suit your individual 

(personal) tastes and needs. The user can personalize the Windows 10 desktop, theme, window colors, 

lock screen, sounds, font size and more on his computer according to his preferences. 

Ways to open Personalization Settings in Windows 10: 

- right-click on the desktop, select Personalization; 

- Start > Settings > Appearance and Personalization. 

A theme is a combination of desktop background pictures, window colors, and sounds. 

Windows computers ship with a theme already in place. Many users opt for the default 

configuration during installation or setup, and thus, the most common elements are applied 

automatically, but the user can create and customize a new theme as desired. 

To change the desktop background image, select Background > Browse, and then select the 

image you want. 

However, if the Windows 10 OS is NOT ACTIVATED, the user will not be able to change the 

theme or wallpaper on the desktop due to the fact that the personalization settings will be locked 

(Figure 8). 

If the OS is not activated, but the user needs to change the background image, then he needs to 

do the following: 

- right-click on any image on his computer. The image must match the proportions of the screen 

and have sufficient resolution so that the background image on the screen looks organic; 

- select Set as desktop background in the context menu. 
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Figure 8. Personalization Settings (Windows 10 OS is not activated) 

 

To change the theme for a non-activated Windows 10 OS, you need to disable the Prevent 

changing the theme using Group Policy option. 

To disable Prevent changing theme setting using Group Policy, follow these steps: 

- download the theme you like – a file with the *.themepack extension from the official 

Microsoft repository; 

- press Win+R to open the Run prompt on your PC; 

- type gpedit.msc, and press OK button to open the Local Group Policy Editor (Figure 9);  

 

 
Figure 9. Opening the Local Group Policy Editor 

 

- select Administrative Templates > Control Panel > Personalization > double-click the Prevent 

theme changes option (Figure 10). In the window that appears, select the Disabled option (Figure 11) > OK; 

- find the previously downloaded file with the *.themepack extension and open it. The OS 

theme will change (Figure 12). The background image of the desktop and the color scheme of the start 

menu will change. To return to the previous theme, you need to select Default themes (Figure 13). 
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Figure 10. Selecting the Prevent Changing Theme option 

 

 
Figure 11. Disable the Prevent Changing Theme option 

 

               
Figure 12. Changing the OS theme 
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Figure 13. Selecting the default Windows theme 

 

4. Customizing the view of desktop icons  

Right-click on the desktop > View > select the size of the icons and the principle of their 

arrangement on the desktop (Auto arrange icons or Align icons to grid) (Figure 14). 

 

 
Figure 14. Customizing the view of desktop icons 

 

Some folder settings in Windows 10. 

1. Setting up the presentation of the folder (file) structure.  

This PC  > select any folder in Explorer and open it > View tab. In the Layout group, you can 

present folders in the form of a list, a table, and increase or decrease the size of the icons (Figure 15). 
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Figure 15. Setting up the presentation of the folder (file) structure 

 

2. Grouping or sorting folders (files). 

This PC > select any folder in Explorer and open it > View tab > Current view group > Sort by (Figure 16). 

 

 
Figure 16. Sorting folders (files) 

 

3. Changing the folder icon on the desktop 

Any version of Windows OS has the main desktop icons: This PC, Recycle Bin and Control 

Panel. To change their appearance do the following: 

- in the Start menu, select Settings (or press Win+I ); 

- go to  Personalization section > Themes tab > Desktop icon settings; 

- pick an icon from the list and click OK. Or you can click Browse to select a custom icon. 

- click Apply and OK. 

4. Changing the folder icon 

- download the new icon for the folder with the *.ico extension; 

- select the folder > right-click on it > Properties > Settings > Change icon (Figure 17) > Browse 
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> find the previously downloaded file, select it > Apply > OK. 

- if the icon has not changed, press the F5 key; 

- if you don’t like the icon, you can restore the default values. 

 

 
Figure 17. Changing the folder icon 

 

The Windows command prompt is one of the most powerful utilities on a personal computer 

running Windows. The command prompt can be used to execute specific commands and perform 

advanced functions. If you need to troubleshoot your Windows laptop or computer, you may need to 

run the command prompt.  

You can launch command prompt using a variety of easy methods: 

- press Win+R keys to open Run program. Type the cmd command and press OK (Figure 18); 

- right-click on Start and select Command Prompt from the menu that opens; 

- in the search bar on the start screen type cmd. Click Command Prompt in the menu that opens; 

 

 
Figure 18. Launching the Command Prompt 

 

Commands for files and directories (folders) management in the Command Prompt [5], [6]: 

1. cd -  changes directory (Figure 19); 

2. dir -  displays files and folders in current directory. After entering the command, press Enter 

(Figure 20). 
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Figure 19. Changing the current SKMA-7979 directory to the Desktop directory 

 

 
Figure 20. Viewing the contents of the Desktop directory 

 

3. mkdir – creates a directory. After command type the name of the directory and its path  (Figure 21); 

 

 
Figure 21. Creating a new directory marina on drive C 

 

4. fsutil file createnew *.txt  4000 - creates a text file, instead of * type the file name, 4000 is 

the file size in bytes (the size can be changed) (Figure 22); 
 

 
Figure 22. Creating a text file ivanova with a txt extension of 4 KB in size 

 

5. copy con *.txt - creates a text file from the Command Prompt, allowing users to type in the file's 

content and save it. After command copy con type file name with extension txt, press the Enter key to enter 

the file's content. Type the content you want to include in the Command Prompt. To end the input and save 

the file, press Ctrl + Z, followed by the Enter key. The file will be saved in the current directory (Figure 23); 
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Figure 23. Creating a text file example.txt containing the sentence 

ICT is really important subject 

 

6. del -  deletes files. After command del type the file name with extension. To delete all files 

from the current directory, use the del * command (Figure 24). To delete files only with a specific 

extension, for example, docx, enter del *.docx; 

 

 
Figure 24. Deleting files from the marina directory 

 

7. rmdir - deletes a directory. After command type the directory name and it’s path (Figure 25). 

The rmdir command is used to delete EMPTY directories on the system; 

 

 
Figure 25. Deleting the marina directory 

 

8. rename – renames a file or directory. After command type the old file name, then the new 

one (Figure 26). 

 
Figure 26. Renaming the marina directory to ivanova 

 

9. copy –  copies files.  After command type the file old path and then the new one (Figure 27). 
 

 
Figure 27. Copying the example.docx file from the Desktop to the ivanova directory 
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10.  move – moves files or directory  from one directory to another. After command type the file 

(directory) name and it’s path then it’s new path (Figure 28). 

 

 
Figure 28. Moving the example.docx file from the Desktop to the marina directory located on the 

disk c: 

 

11. tree - shows directory structure of a disk or folder (Figure 29). 

 
Figure 29. Displaying the Documents directory tree 

 

Other useful Commands of Command prompt: 

1. ver – allows you to view the Windows version (Figure 30); 

 

 
 

Figure 30. Viewing the OS version 
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2. date - outputs or sets the current date. To change the current date you must have administrator 

rights (Figure 31); 

 

 
Figure 31. Viewing and changing the current date 

 

3. time – displays or sets the system time. To change the current time you must have 

administrator rights (Figure 32); 

 

 
Figure 32. Viewing and changing the current time 

 

4. start – opens web-page. After command type the web-page address (Figure 33); 

 

 
Figure 33. Opening a web-page via the Сommand prompt 

 

5. cls - clears screen; 

6. exit – exits the Command prompt; 

7. shutdown/r - restarts the computer. 

Tasks  

Task 1. 

Construct a diagram containing information about OS types. Give examples for each type of 

OS. 

Task 2. 

Change some Windows OS settings: 

a) View the properties of the OS you are using via: 

- This computer icon; 

- Settings App; 

- Control Panel component; 

b) Change the OS language from Russian to Kazakh (or English) and change again to Russian; 

c) Change the OS region to Kazakh (Kazakhstan), open Calendar and view changes. Change 

the region to Hindi (India), open Calendar to view the changes. RESTORE the region to Russian 

(Kazakhstan); 

d) Download the desktop theme from the official Microsoft repository. Apply it. View changes. 

RESTORE default Windows theme; 

e) Experiment by changing the appearance of desktop icons (large, small, medium) and their 
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location on the desktop (auto arrange icons, align icons to grid). RESTORE icon settings – medium 

and align icons to grid; 

Task 3. 

Change some folder settings in Windows 10: 

a) Change the Documents folder settings: 

- view – table; 

- sorting - by date created and descending; 

- with file name extension. 

b) Change the This PC icon to another one suggested by the OS, then RESTORE the default 

icon. 

c) Download the icon for the folder in .ico format. Apply it to the Downloads folder. RESTORE 

the default icon. 

Task 4. 

Working in Command prompt mode 

1. Change the current directory to drive C. 

2. Create a directory with your name and go to it. 

3. In the directory with your name, create an ICT subdirectory and go to it. 

4. Create two subdirectories in the ICT directory: PRACTICE and SIW. 

5. Go to the PRACTICE directory and create subdirectories LESSON1 and LESSON2. 

6. Go to the LESSON1 directory and create 2 text files in it: the first with the name 

DEFINITION, the second with the name TABLE. 

7. The DEFINITION file must contain the following information: 

Computer is an electronic device that is designed to work with information 

8. Rename the DEFINITION file to GLOSSARY. 

9. Copy the GLOSSARY file to the SIW directory. 

10. Move the TABLE file from the LESSON1 directory to the LESSON2 directory. 

11. View the contents of the directory with your name. 

12. Display the directory tree with your name. 

13. Delete the TABLE file from the LESSON1 directory. 

14. Remove all subdirectories from the ICT directory. 

15. Rename the ICT directory to EXAMPLE. 

16. View OS version. 

17. View the current date and time. 

18. Using the Command Prompt go to the SKMA website https://skma.edu.kz/. 

19. Clear the Command prompt. 

20. Restart the computer using the Command prompt. 

Task 5.  

Answer the control questions 

5. Teaching methods/technology: 

Teaching methods:  

- by external signs of the activity of the teacher and students: story, demonstration, 

instruction; 

- by source of knowledge: visual (use of technical means - computer, projector), practical 

(performing practical tasks); 

- according to the degree of activity of students’ cognitive activity: problem-based, partially 

search, illustrative, explanatory. 

Teaching technology: 

-    computer training. 

 

https://skma.edu.kz/
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6. Assessment methods/technology: 

Individual student report made in MS Word in electronic format. 

Report Contents 

1. Result of task 1 is a diagram constructed using the MS Word SmartArt tool. 

2. Results of task 2 - changing some Windows OS settings – screenshots describing user actions 

with comments. 

3. Results of task 3 - changing some folder settings in Windows 10 - screenshots describing 

user actions with comments. 

4. Results of task 3 - working in Command prompt  mode - screenshots describing the progress 

of the task. 

5. Answers to control questions. 

7. References 

1. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the Ministry 

of Education and Science of the Republic of Kazakhstan) 

2. Нурпеисова Т.Б., Кайдаш И.Н. ИКТ. Учебное пособие / Алматы, изд-во Бастау, 2017 

3. Nurpeisova T.B., Kaidash I.N. ICT, Almaty, Bastau, 2017. 241 p.  

4. https://ithelperaddress.com/full-lab-9-commands-for-beginners-learning-the-command-prompt-

in-windows/  

5. http://pcprintinfo.ru/?p=2624  

6. https://medium.com/beyondx/windows-cli-basics-600b0e46fdbe 

8. Control  questions: 

1. What is an operating system? Give examples of OS. 

2. What characteristics does Windows 10 have? 

3. What functions does the operating system perform? 

4. What is the purpose of a file system? 

5. What is a file? Give examples of files with different extensions. 

6. What is a directory? 

7. What is an interface? 

8.Which built-in application is used to change most Windows10 OS settings? List several ways to 

open it. 

9.What is Personalization in the OS? What changes can be made using the Personalization in 

Windows? 

10. List the advantages and disadvantages of the command prompt interface? 

11. What command prompt commands are used to work with directories? 

12. What command prompt commands are used to work with files? 

 

Class 3 

1. The theme: Determination of requirements to development "convenient in application" the 

website. 

2. The goal:  The goal of this lesson is to provide students with interactive web pages and create a 

simple website. 

3. The learning objective: Having studied this class the student can get idea about: 

      -interactive web page; 

-about creating a web site 

4. Key questions of the theme: 

1. What is web technology? 

2. What is a webpage? 

3. What is the Mobirise? 

https://ithelperaddress.com/full-lab-9-commands-for-beginners-learning-the-command-prompt-in-windows/
https://ithelperaddress.com/full-lab-9-commands-for-beginners-learning-the-command-prompt-in-windows/
http://pcprintinfo.ru/?p=2624
https://medium.com/beyondx/windows-cli-basics-600b0e46fdbe
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4. Structure of the Mobirise. 

5. What is the block for webpage? 

Tasks: 

6. 1. Practical exercises: using the Mobirise program, create and arrange a site on the following 

topics:   

7. а) advertising site of the South Kazakhstan Medical Academy   

8. b) advertising site of your faculty   

9. с) advertising site of the city of Shymkent    

10. d) advertising site of the medical center, dental clinic, pharmacy   

11. https://drive.google.com/file/d/1RdQLyhGx3YQZLbfk-gUUlwMDQX6_q0dG/view?usp=sharing 

12. https://drive.google.com/file/d/1OI8WIHODuPnWZuEPnywi_bvx1svefFa5/view?usp=sharing  

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Computer based teaching, project method. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey.  

7. References 

1. Craig Van Slyke  Information Communication Technologies: Concepts, Methodologies, Tools, 

and Applications (6 Volumes), 2013. - p. 4288. 

2. Brian K. Williams, Stacey C. Sawyer Using information technology: a practical introduction to 

computers &communication: complete version, New York, 10020. Copyright © 2011 by the 

Mcgraw-Hill, 606 p. 

3. Kevin Bond and Sylvia Langfield AQA Computing - Nelson Thornes Ltd 2009. 

4. Lindros K. PC Basics with Windows 7 and Office 2010. - Jones & Bartlett Learning. 2012.  

8. Control questions. 

1. What is web technology? 

2. What is a webpage? 

3. What is the Mobirise? 

4. Structure of the Mobirise. 

5. What is the block for webpage? 

 

Class 4 

1. The theme: Development of database structure, creation of tables and requests.  

2. The goal: Acquaintance of students with the database management system and introduce one of  

DBMS: SQL. Creating a medical database: tables, queries. Work with forms and reports. 

3. The learning objective: Having studied this class the student will be able to: 

- create a tables; 

- work with tables; 

- import data from other sources; 

- understand what queries are; 

- create a queries; 

- understand what forms are; 

- create a forms; 

-understand what reports are; 

- create a reports. 

4. Key questions of the theme: 

1. What is a Database? 

2. What types of database do you know? 

3. What is MS Access? 

4. What main objects of MS Access do you know? 

 

https://drive.google.com/file/d/1RdQLyhGx3YQZLbfk-gUUlwMDQX6_q0dG/view?usp=sharing
https://drive.google.com/file/d/1OI8WIHODuPnWZuEPnywi_bvx1svefFa5/view?usp=sharing
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Practical tasks 

1. Creating a single-table database.                                                                                         

1.1 Start MS Access. 

1.2 In the Blank database pane on the right-hand side in the window enter the name of database 

“General medicine”. 

1.3 Click on the Browse button (yellow folder) and choose where you would like to save this database. 

Press OK. 

1.4 Click on  the Create (Создать) button and you will be present a new database. 

1.5 Select the Create (Создание) tab in the toolbar at the top of the screen, then click on the Table 

Design (Конструктортаблиц) button  in the Tables group(Таблицы).  

1.6 At the top of the Table Design window in each row, enter a field names and data types (see table 

bellow). Use figure 1 as a guide. 

 

Field Name (Имя поля) Data Type (Тип данных) 

DoctorID Number (Числовой) 

FirstName Short Text (Текстовый) 

LastName Short Text (Текстовый) 

Position Short Text (Текстовый) 

CabinetID Number (Числовой) 

WorkingTime Short Text (Текстовый) 

Services Short Text (Текстовый) 

 

 
Figure 1. 

 

1.7 In the clinic are two floors and cabinets ID within the range of from 100 to 130 and from 200 to 

230. 

At the bottom of the  Table Design window in the Field properties (Свойств аполя) partenter the 

condition for the Cabinet ID field. 

In the Condition for value (Условие назначение) row click the Expression Builder(Построитель 

выражений) button , enter the condition:  >=100 and <=130 or >=200 and <=230. 

In the Error information (Сообщение об ошибке) row enter “This ID isn’t found”(figure 2). 

1.8 Once all the fields are added, click the Save icon. Enter a table name “Doctors”. Click OK and 

you will see your table in the navigation pane. 

1.9 A primary key is a field or set of fields with values that are unique throughout a table. Values of 

the key can be used to refer to entire records, because each record has a different value for the key. 

Each table can only have one primary key. 
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Figure 2. 

  

Make the DoctorID a primary key for this table, so select DoctorID field, click on Primary Key 

(Ключевое поле)  option in the ribbon. 

You can see a little key icon that will show up next to that field.  

1.10 Save the table and give this table  name “Doctors”.  

2. Practical task. Filling the database.                                                                                                                                

2.1 Creating a lookup fieldsin MS Access tables can help improve the efficiency of the data entry 

process for your database. A lookup field can display a user friendly value that is bound to another 

value in the source data table or value list. 

2.2 Create the table  Time_Lookup Field (figure 3). This table will be used as lookup field for Working 

Time field from “Doctors” table. 

 

 
Figure 3. 

 

2.3 Create in MS Excel the table Type Of Service_ Lookup Field  (figure 4). 

 

 
Figure 4. 

 

This table will be used as lookup fieldfor Services field from “Doctors” table. 
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2.4 Define cell format – Text (Текстовый). Save the table Type Of Service_ LookupField  on the 

desktop.  

2.5 Open database “Stomatology”go to External data (Внешние данные) tab, selectExcel option. 

2.6 Browse the Excel file from which you want to import data, select the file Type Of Service_ Lookup 

Field. 

1.6. In the next dialog box Import of spreadsheet (Импорт электронной таблицы) select List 1 

(Лист 1), click Next (Далее)  button.  

2.7 In the Preview, you can  see that the first row contains the column headings. Check the check box 

and click Next (Далее). 

2.8 You will see a dialog box where you can set the data type for each field. If you don’t want to 

import any field, just check the check box which says do not import field. Click Next (Далее) button. 

Here are the different options for primary key. Select the last option No primary key (Не создавать 

ключ) and click Next (Далее). 

2.9 In the last dialog box enter the table name “Type Of Service_ Lookup Field” and click Finish 

(Готово). 

2.10 Go to the Navigation pane. The new table is added here and when you open the newly added 

table you will see all of your data in Access. 

2.11 Create the table Staff_Lookup Field (figure 5). This table will be used as lookup field for Position 

field from “Doctors” table. For Salary and Bonus fields select Currency (Денежный) format.  

2.12 Make the Position  a primary key for this table. 

 

 
Figure 5. 

 

3. Filling the tables.                                                                                                        

3.1 Open the Time_LookupFieldtable, enter the data (figure 6). 
 

 
Figure 6. 

 

3.2 Open the Staff_LookupFieldtable, enter the data (figure 7). 
 

 
Figure 7. 
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4. Creating of Lookup Field.                                                                                                 

Case 1. Table Design (Режим конструктора) 

4.1 Open the Doctors table.  

4.2 Choose Home (Главная) tab. Click Views (Режимы)option in the ribbon. Choose Table Design 

(Конструктор). 

4.3 For Position field in the Field properties (Свойства поля) part select Lookup (Подстановка).  

4.4 In the Dysplay Control (Тип элемента управления) row select Combo box (Поле со списком).  

4.5 In the Row Source (Источник строк) row select Staff_LookupField table (figure 8). 

Case 2. Lookup Wizard (Мастер подстановок) 

4.6 For WorkingTime field in the column Data Typeselect in drop-down menu Lookup Wizard 

(Мастер подстановок) (figure 9).  

 

 
Figure 8. 

 

 
Figure 9. 

 

1.1 In the next dialog box click Next (Далее) button. 

1.2 In the next dialog box select Table Time_LookupField, click Next (Далее) button.  

1.3 In the next dialog box from the Available Fields (Доступны еполя) list, select the Working Time 
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field, and then click the > button to add it to the Selected Fields (Выбранны еполя) list, clickseveral 

times Next (Далее) button. 

1.4 Click Finish (Готово) button. 

Case 3. Query language SQL  

1.5 For Working Time field in the Field properties (Свойства поля) part select Lookup 

(Подстановка).  

1.6 In the Dysplay Control (Тип элемента управления) row select Combo box (Поле со списком). 

1.7 In the Row Source Type (Тип источника строки) row select Table/Query (Таблица или запрос). 

1.8 In the Row Source (Источник строк) row click the Expression Builder (Построитель 

выражений) button  and select View (Режим), SQL View (figure 10). 

 

 
Figure 10. 

 

The query is:  

SELECT Time_LookupField.WorkingTime FROM Time_LookupField; 

INDEPENDENTLY create the lookup field for Services field. 

4.15 Enter the data in the Doctors table, use lookup fields (figure 11). 

 
Figure 11. 

 

2. Practical task. Inserting of the OLE Object.                                                                                                              

2.1 Save several photos of different people in the any folder in *.bmp format. 

2.2 Open the“Doctors” table.  

2.3 In the Home (Главная)tab of the ribbon click the Views (Режимы) option and choose Table 

Design (Конструктор).  

2.4 Add a new field Doctor Photo, type of data – OLE Object (Поле объекта OLE). 

2.5 Select the Home (Главная) tab in the toolbar at the top of the screen, then click the Views 

(Режимы) group and select Datasheet View (Режим таблицы).  

2.6 Right-click the Doctor Photo field and choose Add object (Вставить объект). 

2.7 In the dialog box select Create from the file (Создать из файла). 

2.8 For searching of the file, use the Browse (Обзор) button (figure 12). Click OK. 
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Figure 12. 

 

6. Practical task.Adding a new field in the table.                                                                                                        

6.1 Open the“Doctors” table.  

6.2 In the Home (Главная)tab of the ribbon click the Views (Режимы) option and choose Table 

Design (Конструктор).  

6.3 Add a new field “Phone”, type of data –Short Text (Текстовый). 

6.4 Click on the Input Mask (Маскаввода) box on the General (Общие) tab of the Field 

Properties pane at the bottom of the window. 

6.5 Click the button  to the right of the Input Mask field. This will open the Input Mask wizard 

which will walk you through the process. 

6.6 Save the table. 

6.7 In the dialog box selectList (Список) button. 

6.8 Enter the data. Use figure 13 as a guide. 

 
Figure 13. 

 

6.9 Click the Close (Закрыть) button. 

6.10 Click  the Input Maskfrom list for Phone field.  

6.11 Click the Finish (Готово) button. 

6.12 Enter the data for Phone field in “Doctors” table (figure 14). 

 
Figure 14. 
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7. Practical task. Filtering of data.                                                                                                                                             

7.1 Open the“Doctors” table.  

7.2 Select the Home (Главная)tab,then click on the Views (Режимы) group and select Datasheet 

View (Режимтаблицы).  

7.3 Select the Position field.  

7.4 Click on Filter (Фильтр) option in the ribbon.  

7.5 Select Orthopedist record, click OK. 

7.6 The records that contain “Orthopedist” are displayed  (figure 15).  

 

 
Figure 15. 

 

7.8 Click on Remove Filter (Удалить Фильтр) option in the ribbon. All the records in 

the table are displayed. 

7.9 Rename the fields  Firs tName to Doctor First Name, Last Name to Doctor Last Name in the table 

Doctors. 

8. Practical task. Creating a new tables.                                                                              

8.1 Start MS Access. 

8.2 Create a “Patients” table.Enter a field names and data types (see table bellow) (figure 16). 

Field Name (Имяполя) Data Type (Типданных) 

PatientID Number (Числовой) 

PatientLastName Short Text (Текстовый) 

Address Short Text (Текстовый) 

HealthInsurance Short Text (Текстовый) 

Phone Short Text (Текстовый) 

Gender Short Text (Текстовый) 

 

 
Figure 16. 

 

8.3 Create anInput Mask (Маска ввода) for Health Insurance field. Use model AB-1234. 

8.4 Create anInput Mask (Маска ввода) for Phone field. See  task 7. 

8.5 Fill the table (not less than 15 records) (figure 17). 
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Figure 17. 

8.6 Create a “Services” table. 

8.7 Enter a field names and data types (see table bellow). 

 

Field Name (Имяполя) Data Type (Типданных) 

ServiceID Number (Числовой) 

TypeOfService Short Text (Текстовый) 

CharacteristicsOfService Short Text (Текстовый) 

Price Currency (Денежный) 

Discount Number (Числовой) 

 

8.8 Fill the table.Use figure 18 as a guide. 

 
Figure 18. 

 

8.9 Create a “Journal” table. 

8.10 Enter a field names and data types (see table bellow). 

 

Field Name (Имяполя) Data Type (Типданных) 

Date Date&Time (Дата и время) 

PatientID Number (Числовой) 

PatientLastName Short Text (Текстовый) 

DoctorLastName Short Text (Текстовый) 

Position Short Text (Текстовый) 

Services Short Text (Текстовый) 

Quantity  Number (Числовой) 
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8.11 For PatientID field create the lookup field from Patient table. 

8.12 For DoctorLastName field create the lookup field from Doctors table. 

8.13 For Services field create the lookup field from Services table. 

8.14 PatientLastName and Position fields don’t fill. 

9. Practical task.Creating the form.                                                                                            

9.1 Open Stomatology.accdb file. 

9.2 Select the Create (Создание) tab, then click on the Form Wizard  (МастерФорм) button  

 in the Forms group.  

9.3 From Tables/Queries (Таблицыизапросы) drop-down list, select Doctors table. Click on the 

double arrow to move all the fields at once, then click Next (Далее) button. 

9. 4 The following screen in the Form Wizard (Мастерформ) will ask for the layout that you would 

like for  form. You have columnar (водинстолбец), tabular (ленточный), datasheet (табличный) 

and justified (выровненный) layouts. Choose the justified layout here and then click Next (Далее). 

9.5 Give a “Doctors” name for the form. Choose the first option to Open the form to view or enter 

information (Открыть форму для просмотра и ввода данных) and click Finish (Готово) button 

(figure 19). 

 
Figure 19. 

 

10. Practical task.Creating thesimple query.                                                                                                              

Queries are a way of searching for and compiling data from one or more tables. 

10.1 Open Stomatology.accdb file. 

10.2 Select the Create (Создание) tab, then click on the Query Wizard  (Мастер Запросов) button 

  in the Queries (Запросы) group. 

10.3 Select Simple Query Wizard (Простой запрос)then click OK.  

10.4 From Tables/Queries (Таблицыизапросы) drop-down list, select Doctors table. Use the arrows 

to move the fields from the Available Fields (Доступные поля):window into the Selected Fields 

(Выбранные поля): window. Select Doctor ID, Doctor Last Name, Position fields. Click OK.  

10.5 Give this query name “Doctors Positions”, click Finish (Готово) button and you will see your 

query in the navigation pane. 
https://www.youtube.com/watch?v=bKUd1RoDVJ4 

https://www.youtube.com/watch?v=x_29t3IKULU 

https://www.youtube.com/watch?v=49Z2XhHawF0 

https://www.youtube.com/watch?v=bKUd1RoDVJ4
https://www.youtube.com/watch?v=x_29t3IKULU
https://www.youtube.com/watch?v=49Z2XhHawF0
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5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Computer based teaching, project methods. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey. 

7. References 

1. Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technologies. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p., 

ISBN 978-601-7911-04-1 (A textbook in English with the stamp of the Ministry of Education and 

Science of the Republic of Kazakhstan)  

2. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. - 410 p.,  ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the 

Ministry of Education and Science of the Republic of Kazakhstan) 

3. Rendell I., Mott J. Advanced database projects in Access 2007. –London, Hodder Education. 

2014. 

4. https://support.office.com/en-ie/article. 

8. Control  questions. 

1. What are the different ways to create a table in an MS Access database? 

2. What are the different ways to create a query, a form in, a report an MS Access database? 

3. What is SQL Server? 

4. How and why use it? 

5. What are the features of MySQL? 

 

Class 5 

 

1. The theme: Design and creation of the presentations of lecture material, scientific reports, etc. 

2. The goal: The aims of this class are to give an idea of Forming ideas of stages of creation of the 

presentation Microsoft Office PowerPoint. Develop skills, additions of drawings, charts and 

diagrams. Apply special effects, animations, sound and video fragments to strengthening of 

perception effect of the main information 

3. The learning objective: Having studied this class the student can get idea about: 

- Creating and Editing a Presentation 

- The PowerPoint Window 

4. Key questions of the theme: 

1. Which of the following method can insert a new slide in current presentation? 

2. Which command will you use in PowerPoint if you need to change the color of different objects 

without changing content? 

3. Which file format can be added to a PowerPoint show? 

4. What is a slide-title master pair? 

5. How can you create a uniform appearance by adding a background image to all slides? 

6. Which option on the custom animation task pane allows you to apply a preset or custom motion 

path? 

7. Which of the following features should you use when typing in the notes text box? 

Tasks  (25-50) 

Create presentation on following themes: 

1. “My future profession” 

2. “My family” 

3. “My university” 

4. “My hobby” 

https://support.office.com/en-ie/article
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5. “Information technologies” 

6. “Computer devices” 

7. “Holidays” 

8. “Travelling” 

9. “World Wildlife” 

10. “Nature” 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Computer based teaching. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey. 

7. References 
1.Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – Almaty, 

2016. - 410 p.,  ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the Ministry of 

Education and Science of the Republic of Kazakhstan) 

2.Lorenzo Cantoni (University of Lugano, Switzerland), James A. Danowski (University of Illinois 

at Chicago, IL, USA) Communication and Technology, 576 p.   

3.Lindros K. PC Basics with Windows 7 and Office 2010. - Jones & Bartlett Learning. 2012. 

4.Torben Lage Frandsen. Microsoft Office PowerPoint. – Ventus Publishing Aps. 2011. – 85. 

8. Control questions.  
1. Which file format can be added to a PowerPoint show? 

2. What is a slide-title master pair? 

3. How can you create a uniform appearance by adding a background image to all slides? 

4. Which option on the custom animation task pane allows you to apply a preset or custom motion 

path? 

 

Class 6 

 

1. The theme: Processing of numerical information, editing formulas and creation  

of charts in spreadsheet editors. 

2.The goal: The objectives of this class are to provide knowledge and skills in performing 

calculations for the input data using the formulas and basic functions available in MS Excel, as well 

as in sorting / filtering the necessary data from an Excel sheet. 

3. The learning objective: Having studied this class the student will be able to: 

- insert formulas by using arithmetic operations with contents of the cells; 

- use the basic functions; 

- sort a given list of data into a given criteria; 

- filter the required data from a data set satisfying a given condition(s); 

- format the cells and the contents. 

4. Key questions of the theme: 

1. What are the advantages of using computerized Spreadsheets? 

2. What are the four different types of operators use in Excel 2010?  

3. What is the absolute and relative addressing of cells? 

4. What kind of categories of functions embedded in MS Excel do you know? 

5. What kind of errors in Excel do you know? 

6. When use a “Filter” and “Sort” tools? 

7. What are the available tools in Excel 2013 to customize charts? 

Practical task.                                                                                                                                                                                                 
1. Start MS Excel. 

2. Create a new workbook and save it as “Marks.xls”. 
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3. Change the name of the worksheet “Sheet1” (Лист1) to “Marks1”. (Right-click on the sheet name 

and choose “Rename” (Переименовать)and rename it). 

4. Delete the “Sheet2” (Лист2) and “Sheet3” (Лист3). 

5. Insert a new worksheet and name it as “Marks2”. 

6. Using figure 1 as a guide, create the table in the worksheet “Marks1”. . 

7. First type the names of the columns. 

8. Mergethe necessary cells. 

9. Select the column C (Index No) and change the column width (Home (Главная)→ Cells (Ячейки) 

→ Format (Формат) → Cell Size (Размер ячейки) → AutoFit Selection (Автоподбор ширины 

столбца)). 

10.  Select the column D (Name) and change the column width (Home (Главная) → Cells (Ячейки) 

→ Format (Формат) → Cell Size (Размер ячейки) → Column width (Ширина столбца) and 

give a suitable width). 

11. Change the width of the column H using mouse double-click. 

12.  Change the column width of column J using click on left mouse button on the column header. 

13.  Select the second row (Index No, Name, …, Total, Average) and change font size to 14 and the 

row height to give a suitable height. 

14.  Change the height of row using mouse (put the mouse pointer at the bottom edge of the row 

number (1,2,…) and move the mouse while pressing the left mouse button). 

15.  Complete the rest of the table as follows. 

 Insert a picture as shown below.  

16. Click cell H10 and enter the formula: =E10+F10+G10    press Enter button. 

17.  Click cell H10, position the pointer on the lower-right corner of the cell (the fill handle) so that 

the pointer change to , drag the to cell H23, then release the mouse button. 

18.  Click cell I10 and enter the formula:  =AVERAGE (E10:G10)      (=СРЗНАЧ (E10:G10)) press 

Enter button. 

19. Drag the fill handle from cell I10 to cell I23. 

 

 
Figure 1. 

 

20. Change the colors of column E, F and G to yellow, red, and orange respectively. 

21. Apply a pattern to the text area of column B. 

22.  Apply cell styles (стилиячеек) to the columns H and I. 

23.  Save your work.  

2. Practical task.                                                                                                                                                                                     
1. Start MS Excel. 

2. Create a new file, then save it as “Payroll Calculator”. 
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3. Using figure 2 as a guide, create the table “Health Professionals Payroll Calculator”. 

4. Click cell F11 and enter the formula: =C11*E11      press Enter button. 

5. Drag the fill handle from cell F11 to cell F20. 

Click cell G11 and enter the formula: =D11*(2*E11)  press En 

ter button.  

At Hippocrates Medical Clinic, overtime pay is calcul 

ated at twice the regular hourly rate times the number of overtime hours. The formula used to calculate 

overtime pay for the employee in row 11 is: O/T Hrs times (2 times Hrly Rate). 

 

 
Figure 2.  

 

6. Drag the fill handle from cell G11 to cell G20. 

7. Click cell H11 and enter the formula: =F11+G11    press Enter button.  

8. Drag the fill handle from cell H11 to cell H20. 

9. Click cell A21 and enter the word “Total”. 

10. Click cell C21 and click the Sum button in the Editing (Редактирование)group on the Home 

(Главная) tab on the Ribbon. In cell C21 formula: =SUM(C11:C20)    (=СУММ(C11:C20)) will 

appear. 

11. Click cell C21 and drag the fill handle from cell C21 to cell H21. 

12. Change the colors of row 21 to yellow. 

13. Save your work. 

 
Figure 3.  
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3.Practical task.  Creating charts.     

                                                                                                                             

 
Figure 4.  

 
1.Start Excel. Open the file “Insurance Reimbursement Analysis”. 

2. Select the range A9:E17, then click the Insert tab (Вставка) on the Ribbon. 

3. Click the Column (Гистограмма) button in the Charts group, then choose picture  in the 

chart gallery (figure 5). 

 

 
Figure 5. 

 

4. Select the range A10:A17, press and hold  Ctrl button, select the range F10:F17, release Ctrl 

button, click the Insert tab (Вставка), click the Pie button (Круговая) in the Charts group, then 

choose picture  in the chart gallery. 

5. Edit chart as shown in figure 6. 
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Figure 6. 

 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Computer based teaching. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey. 

7.References 

1. Нурпеисова Т.Б., Кайдаш И.Н. ИКТ. Учебное пособие / Алматы, изд-во Бастау, 2017 

2. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. - 410 p.,  ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the 

Ministry of Education and Science of the Republic of Kazakhstan) 

8. Control questions. 

1. What are the advantages of using computerized Spreadsheets? 

2. What are the four different types of operators use in Excel 2010?  

3. What is the absolute and relative addressing of cells? 

4. What kind of categories of functions embedded in MS Excel do you know? 

5. What kind of errors in Excel do you know? 

6. When use a “Filter” and “Sort” tools? 

7. What are the available tools in Excel 2013 to customize charts? 

 

Class 7 

 

1. The theme: Creation of a simple network configuration. IP addressing. Monitoring of a network. 

Analysis of traffic. Use of sniffers for the analysis of network packets  

2. The goal: The aims of this class are to develop a solid grasp of network by introducing the basic 

concepts. 

3. The learning objective: Having studied this class the student will be able to: 

- describe what a computer network is; 

- define the basic terminology; 

- classify the networks according to the scale; 

- describe what LAN, MAN, and WAN are; 

- classify the networks according to the topology; 

- identify the basic hardware used in networking computers; 

- describe what Internet, Intranet, and Extranet. 

4. Key questions of the theme: 

1. Why do we need to connect computers? 

2. What is a computer network? 

18%

11%

12%
12%11%

6%

10%

20%

Cardiology Dermatology Immunology Neurology
Opthalmology Ortipedics Pediatrics Psychology

Reimbursements, by Department



 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.42 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

3. What is the use of a modem? 

4. What kind of network topologies do you know? 

5. What is meant by Internet and Intranet? Why it is important to use Intranet than Internet? 

Tasks 

1. Make a glossary for the following terms:                                                                                                 

bandwidth, bluetooth, client/server network, ethernet, fiber-optic cable, host computer, intranet, 

internet, IP address, local area network (LAN), mesh network, network, node, peer to peer, personal 

area network (PAN), protocol, ring network, star network, topology, twisted-pair wire, virtual private 

network (VPN), wide area network (WAN), wi-fi.   

 

2. Label the photos with the network hardware in the table below.                               

 

 
1 ______________   2 ___ Optical fiber __________    3 ______________  4 ______________ 

 

 
5 ___________________6____________________7____________________ 

 

Network Interface Card Hub  

Switch  Coaxial cable 

Router  Optical fiber 

Twisted-pair wire  

 

3. Match the words 1-8 to the descriptions a-h.                                                                               

1. Modem A is an entrance to another network 

2. Repeater B channels incoming data but maintains the bandwidth 

speed 

3. Bridge C allows wireless devices to connect to the network 

4. Router D modulates and demodulates the data into a digital or an 

analog signal  

5. Gateway E channels incoming data but shares the bandwidth among 

the devices present on a network  

6. Switch F sends the digital signal further on in the network 

7. Hub G  connects networks and sends packages of data between 

them 
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8. Wireless access point H connects networks that use the same protocol 

4. Name the following different types of network.                                                                                

 
1 _______________     2 _____star_________    3 ______________    4_____________ 

 

5. Label the diagram of a network using these terms: file server, terminals, cables, print server. (5-

10)                                                                                   

 

 

 

 

 

 

 

 

 

6. Complete the table giving below. Show the features of each type of network using these key terms: 

expensive, economical, single cable, many cables, reliable, unreliable, links to server, links to other 

PC’s.                                                                                                                                                 

 
 A B C 

Cost to set up    

Number of cables    

Links    

Reliability     

 

7. Practical task. Gather TCP/IP Configuration Information.                                                   

1. Use the Start menu to open the command prompt. 

     Start menu (Пуск) → All Programs (Все программы)→Accessories (Стандартные) → 

Command Prompt (Команднаястрока). 

2. Type ipconfig and press Enter button. The following information will appear on the screen (see 

figure 1). 
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Figure 1. 

 

This screen shows the IP address, subnet mask, and default gateway. The IP address and the default 

gateway should be in the same network or subnet; otherwise, this host would not be able to 

communicate outside the network. In the figure, the subnet mask reveals that the first three octets 

must be the same number in the same network. 

3. Record the following TCP/IP information for your computer: 

    IP Address (IP адрес )                       ___________________________ 

Subnet Mask (Маскаподсети)           ___________________________ 

Default Gateway (Основнойшлюз)    ___________________________ 

4. Compare your computer’s TCP/IP configuration to other computers on the LAN. 

Are there any similarities? 

What is similar about the IP address? 

What is similar about the default gateway? 

Record a couple of the IP address. 

5. Type ipconfig/all and press Enter button. The additional TCP/IP configuration information will 

appear on the screen (see figure 2). 

You should see the following information: the host name (имякомпьютера), the DHCP server’s 

address  (адресDHCP-сервера) if used, and the date the IP lease starts and ends. Review the 

information. You might also see entries for DNS servers, which are used in the name resolution. 

You also see the physical (MAC) address (Физическийадрес) and the NIC model (description) 

(Описание).  

In the LAN, what similarities do you see in the physical (MAC) address? 

What is the function of the DNS server? 

 

 



 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.45 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

 
Figure 2. 

 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Work in pairs, partial-search. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey. 

7. References 

1. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. - 410 p.,  ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the 

Ministry of Education and Science of the Republic of Kazakhstan 

2. Bond K., Langfield S. AQA Computing. - Cheltenham: Nelson Thomes Ltd. 2009. – 514 p. 

3. Tanenbaum A., Wetherall D. Computer Networks, 5-th edition. – Prentice Hall. 2010. – 962 p. 

8.Control questions: 

1.Why do we need to connect computers? 

2.What is a computer network? 

3.What is the use of a modem? 

 

Class 8 

 

1. The theme: Cybersecurity.  

2. The goal: The aim of this lesson is for students to understand the state of current cyber-threats 

occurring in our world and leave knowing how to manage their own risk to help reduce this global 

loss. 

3. The learning objective: Having studied this lesson the student will learn the basics of securing 

their devices from outside interference and cyber-criminals, in order to protect their data and 

identity online. 

4. Key questions of the theme: 

1. What are you aware of threats to information security? 

2. What is phishing? 
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3. What is cybersecurity? 

4. What is online privacy? 

5. What is encryption? 

6. How can you prevent a cyberattack on your personal devices?  

Theory: 

1. Cybersecurity 

Computer security is a section of information security that characterizes the impossibility of causing 

damage to a computer in excess of the amount of acceptable damage to it from all identified and 

studied sources of its failures under certain operating conditions and at a given time interval. 

2. Encryption  

Encryption is a process that encodes a message or file so that it can be only be read by certain 

people. Encryption uses an algorithm to scramble, or encrypt, data and then uses a key for the 

receiving party to unscramble, or decrypt, the information. 

3. Phishing  

Phishing is a type of Internet fraud, the purpose of which is to gain access to confidential user data - 

logins and passwords. 

4. Online privacy 

Online privacy is part of data privacy. Privacy concerns have been posed since the beginning of 

large-scale computer-assisted information exchange. ... Personal information is any information that 

can be used to identify a person. 

5. Computer viruses 

A computer virus is a type of malicious software that can inject itself into the code of other 

programs, system memory areas, boot sectors, and distribute copies of itself through various 

communication channels. The main purpose of the virus is to spread it. 

Tasks 

7. Read the theory. 

8. Answer google form questions                                                                    (5-10)                

https://docs.google.com/forms/d/e/1FAIpQLSfgY1XeuGZ2dVORhTuk8FLZcXZJUzD1Ybh17Rn

NuBsqcvnRiA/viewform?usp=sf_link 

9. Using the cipher below encode and decode the words                                (5-10) 

 

 
 

Plaintext Ciphertext 

Encoding 
 

Software  

Algorithm  

https://docs.google.com/forms/d/e/1FAIpQLSfgY1XeuGZ2dVORhTuk8FLZcXZJUzD1Ybh17RnNuBsqcvnRiA/viewform?usp=sf_link
https://docs.google.com/forms/d/e/1FAIpQLSfgY1XeuGZ2dVORhTuk8FLZcXZJUzD1Ybh17RnNuBsqcvnRiA/viewform?usp=sf_link
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Cybersecurity   

 
 

Clue: they used to be the population that used this type of 

cipher the most! 
 

 

4. Define the term"phishing"?:                                                                      (10-20) 

Your answer:__  

._______________________________________________________________________________

_______________________ 

____________________________________________________________________ 

____________________________________________________________________ 

List the signs that indicate that the letters given below are phishing: 

1.__Dear valued customer of TrustedBank 

__We__have__receieved__notice_that_you_have_recently_attempted_to_withdraw__the_followin

g_amount_from____your_checking__account_while__in_another_____country_$135 

25____________________________ 

_Thank__you__________________________________________________________TrustedBank

_________________________________________________________2._Due__Valued_Customer

_______________________________________________Failture_ton do this 24hrs will lead to 

restricted access to your account for security reasons 

__Sorry__fo_the__inconvierce______________________________________________Regards__

____________________________ 

___Royal__Bank__Of_Scotland______________________________________________________

______ 

3.__От:_mail@mail.ru______________________________________________________Дата:_21

_ноября__11:54___________________________________________Кому:__________________

_____________________________________________Тема__Администрация_M@il.ru_______

_____  

4._20 сентября 2004 г. На ваш текущий счет был получен перевод в иностранной валюте на 

сумму, превышающую USD2.000.  

Letter 1. 
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Letter 2. 

 
 

Letter 3. 
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Letter 4. 

 
 

5. Password Strength                                                                                       (5-10) 

Open this site: https://howsecureismypassword.net/ and follow the guide below.   

 

 Create a few passwords using 8 lowercase characters (a-z).  What’s the longest amount of 

time-to-crack you are getting?  

   

 

● Using any characters on the keyboard, what’s the longest amount of time-to-crack you can 

generate with an 8-character password? 

 

 

● What seems to be the single most significant factor in making a password difficult to crack?  

Why do you think this is? 

 

Your answer:__________________________________________________________ 

________________________________________________________________________________

________________________________________________________ 

   

● What should NOT be your password?  

https://howsecureismypassword.net/
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Your answer:_ Any number that people can easily associate with you doesn't belong in your 

password. Phone numbers are too easy to link to your account, and leaving your Social Security 

number in a database (even a supposedly secure password database) is just too dangerous. 

Keep your personal numbers out of your 

password._________________________________________________________ 

____________________________________________________________________ 

 

6. Privacy Activity                                                                                         (10-20) 

Research Yourself 

Overview: Do you know how much data about yourself is freely online? If someone were to research 

you, what would they be able to find? What could they know about you from a simple search? Lets 

go digging for the data you can find about yourself. 

Instructions: Begin by typing in your name. Then, try your name + your school or the name of your 

city. Even try your name + a sport you play! You can look at search engines, your school website, 

social networks, or any other frequently used website! You can even include posts from social media 

sites if you can find them. 

Record What You Find!  

Information Where you found it 

Information about myself https://vk.com/feed 

  

  

  

  

  

  
 

7. Matching Worksheet “Spot the Attack!”                                                     (5-10) 

 

A. Affected over a billion accounts that 

happened right as the company was trying to 

sell their business to Verizon. Users were 

advised to turn on two-factor authentication 

(after you put in your password, it sends a 

code to another device that only you would 

have to make sure it is you logging in, just in 

case a hacker has your password).  

____ WannaCry, 2017 

B. Credit and debit cards were compromised 

right during holiday season. After, 

consumers were advised to check their bank 

accounts for fraud and report unusual activity 

right away.  

____ Uber breach, 2018 

C. World’s most massive ransomware 

attack, affecting over 153 countries and 

____ Yahoo breach, 2016 
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shutting down computers in hospitals. Began 

by companies failing to update their Microsoft 

Operating Systems 

D. Company paid $100,000 to cover up data 

breach that compromised 57 million customer 

records. Breach was not made public until 

months later. 

____ Equifax breach, 2017 

E. Quizzes about personality traits were sent 

to around 300,000 Americans on this 

platform. These “profiles” were sold to a 

company that then used the information to 

tailor political messaging. There has been A 

LOT of recent talk about this scandal.  

____ Abbott Recall, 2017 

F. Compromised the data of 145.5 MILLION 

users, including people who did not even 

know they used this service to manage their 

credit scores. Customers lost trust in this 

company and their stocks plunged. 

___ Facebook Breach of Trust, 2018 

G. FDA announced that a half a million 

pacemakers require a security update because 

of vulnerabilities found that threatened rapid 

battery repletion or altered pacing.  

____ Target, 2014 

H. Confidential documents, including movies 

that were not supposed to be released yet and 

emails from actors were released. 

___ Sony Hack, 2014 

 

8. Describe each type of computer virus                                                       (10-20) 

 

Virus Description 

 Boot Sector Virus  

 Direct Action Virus  

 Resident Virus  

 Multipartite Virus  

 Polymorphic Virus  

 Overwrite Virus  

 Spacefiller Virus  

 File Infector Virus  

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: computer work, partial-search. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task 

7. References 

4. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. - 410 p.,  ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the 
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Ministry of Education and Science of the Republic of Kazakhstan 

5. Bond K., Langfield S. AQA Computing. - Cheltenham: Nelson Thomes Ltd. 2009. – 514 p. 

6. Tanenbaum A., Wetherall D. Computer Networks, 5-th edition. – Prentice Hall. 2010. – 962 p. 

8. Control questions: 

1. What are you aware of threats to information security? 

2. What is phishing? 

3. What is cybersecurity? 

4. What is online privacy? 

5. What is encryption? 

6. How can you prevent a cyberattack on your personal devices?  

 

 Class 8 

 

1. The theme: Adobe Photoshop Express.  

2. The goal: The aim of this lesson is to teach students how to use the free mobile app Adobe 

Photoshop Express to quickly, efficiently, and easily edit photos and create collages. 

3. The learning objective: Having studied this lesson the student will be able to edit photos, use 

various effects and create photo collages. 

4. Key questions of the theme: 

6. Download the Adobe Photoshop Express. 

7. View and select photos. 

8. Edit photos. 

9. Make collages. 

10. Share your work. 

Tasks 

Read the theory. 

https://helpx.adobe.com/photoshop/using/photoshop-express-help.html 

Install a free application Adobe Photoshop Express on your mobile phone using the Play Market   

  .     

Practical task 1.                                                                                       (10-20) 

9.1. Download the picture “Photo 1.jpg” using the link 

https://drive.google.com/file/d/1WArH-e35MWo4abXdJkEGdh265EcYFnBq/view?usp=sharing 

 
Picture 1. 

9.2. Using the “Filters” tool add a “Winter filter” (Picture 2). 

 

https://helpx.adobe.com/photoshop/using/photoshop-express-help.html#Viewandselectphotos
https://helpx.adobe.com/photoshop/using/photoshop-express-help.html#Editphotos
https://helpx.adobe.com/photoshop/using/photoshop-express-help.html#Makecollages
https://helpx.adobe.com/photoshop/using/photoshop-express-help.html#Shareyourwork
https://helpx.adobe.com/photoshop/using/photoshop-express-help.html
https://drive.google.com/file/d/1WArH-e35MWo4abXdJkEGdh265EcYFnBq/view?usp=sharing
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Picture 2. 

 

9.3. Add effects "Raindrops", "Watercolor", "Paper" (Picture 3). 

 
Picture 3. 

 

9.4. Make adjustments (Picture 4). 

 
Picture 4. 

9.5. Add text (Picture 5).  

 
               Picture 5. 
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9.6. Add sticker (Picture 6). 

 
Picture 6. 

 

9.7. Save your project and send to the teacher. 

10.   Practical task 2.                                                                                    (10-20) 

10.1.  Download the picture “Photo 2.jpg” using the link 

 https://drive.google.com/file/d/1Ezfw_-3a5dx5sLeLE6rUohZciDVfTEdA/view?usp=sharing 

 

 

 

 

 

 

       

 

 

 

Picture 7. 

 

10.2.  Open the picture “Photo 2.jpg” in Photoshop Express.  

10.3.  Resize the picture using the “Crop” (“Обрезка”) tool. 

10.4.  Add effect, write text and create a frame. Use picture 8 as a sample. 

10.5. Save your project and send to the teacher. 

 

 
      Picture 8. 

 

11. Using Photoshop Express create Photo collages on the following topics:      (10-20) 

 "My family"; 

 "New Wonders of the World"; 

https://drive.google.com/file/d/1Ezfw_-3a5dx5sLeLE6rUohZciDVfTEdA/view?usp=sharing
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 "South Kazakhstan Medical Academy". 

 

Hint: at the beginning, add no more than 9 photos and use the Photo collage tool (Picture 9). 

 

 
      Picture 9. 

 

12. Create your own projects using the Photo editor Adobe Photoshop Express for the 

following photos:                                                                                         (20-40) 

            
 



 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.56 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

       
5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: computer based teaching 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task 

7. References 

7. Urmashev B.A. Information and communication technology: Textbook / B.A. Urmashev. – 

Almaty, 2016. - 410 p.,  ISBN 978-601-7940-02-7 (A textbook in English with the stamp of the 

Ministry of Education and Science of the Republic of Kazakhstan 

8. Bond K., Langfield S. AQA Computing. - Cheltenham: Nelson Thomes Ltd. 2009. – 514 p. 

9. Tanenbaum A., Wetherall D. Computer Networks, 5-th edition. – Prentice Hall. 2010. – 962 p. 

8.Control questions: 

1.What tools are available in the Photo editor Adobe Photoshop Express? 

2. For which mobile operating systems can the Adobe Photoshop Express app be used? 

3. What is the difference between the PC and mobile versions of the Adobe Photoshop Express 

app? 

4. What is photo collage? 

 

Class 10 

 

1. The theme: Introduction to Google Docs and Microsoft Office Web Apps cloud services. Creation 

accounts to work with cloud services. Study of operation modes associated with file storage, sharing 

and processing. Use of mobile technologies for receiving an information access. GPS navigators. 

GSM a signaling. 

2. The goal: The aims of this class are to introduce the students to Web service in the Cloud and 

Standards of mobile technologies, to introduce the students to Internet, and to give a brief idea on 

Web Browsers and Search Engines. 

3. The learning objective: Having studied this class the student will be able to: 

- efficiency of cloud technologies application  

- list facilities/benefits of cloud technologies; 

- define what Internet is; 

- list facilities/benefits of Internet; 

- describe the ways to connect to Internet; 

- use a web browser to surf the Internet; 

- use search engines to find information on the Internet; 

- create and use an e-mail account; 

- use an electronic services; 

- describe the security and risks involved in Internet. 

 



 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.57 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

4. Key questions of the theme: 

1. What is the Internet? 

2. What is meant by an “Internet protocol”? 

3. What type of telecommunications hardware allow you access the Internet? 

4. What are the advantages and disadvantages of using Wi-Fi as a method of Internet 

connectivity? 

5. What are Web Browsers? 

6. What are Search Engines?  

Practical tasks 

 
 Match these words to A-F in the screenshot of a browser below.                           

1. Web address ______ 4. Tab  ______ 

2. Bookmarks bar  _____ 5. Link ______ 

3. “Back” button _____ 6. “Refresh” button ______ 
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Match these words to A-J in the screenshots of a e-mail below.                             

1. Subject line ______ 6. Forward  ______ 

2. Recipient’s address _____ 7. Blind copy address ______ 

3. E-mail signature _____ 8. Reply button ______ 

4. Attachment button _____ 9. Copy address ______ 

5. Spell checker _______ 10. Delete _______ 

 

1. Write the name of each country listed below next to its correct two-letter Internet domain 

extension. Use online or print resources if necessary.                             

Countries 

Australia  Iceland Russia 

Canada Iraq Sweden 

Chile Israel Taiwan 

Egypt Mexico United Kingdom 

Germany Norway Kazakhstan 

 

Internet Extensions 

1. .cl : ____________________                                   

2. .ca : ____________________                         

3. .au : ____________________ 

4. .eg : ____________________ 

5. .de : ____________________ 

6. .mx: ____________________ 

7. .is : ____________________ 

 

4. Complete the table giving below. Describe the each type of Internet protocols. The first record 

has been completed as an example.         

 

Internet Protocol Refers to Description Internet Services 

SMTP Simple Mail 

Transfer Protocol 

A protocol for sending e-mail 

messages between servers 

E-mail 

POP 3    

FTP    

HTTP    
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HTTPS    

VoIP    

 

5. Complete the table giving below. Describe the each method of Internet connectivity. The first 

record has been completed as an example                                                                                         

  Method Advantage  Disadvantage Best suited for 

Dial-up 

connections  
 Low cost 

 Safety 

 Availability 

 Slow in speed 

 Unstable  

 Need a phone line 

 Phone will be engaged when 

using the Internet 

Places where Internet 

access is needed for a 

longer period 

Landline    

Wi-Fi    

Satellite    

Cell phones    

 

6. Practical task.                                                                                                                                                      

1. Go to www.amazon.co.uk(make a screenshot). And use some of the hyperlinks to browse the 

different sections of the website. Next go to the books section, and find ICT books and create a 

bookmark (make a screenshot). 

2.  Go to www.wikipedia.org and browse using the hyperlinks on the site (make a screenshot). 

Display the History bar and look at the entries for the sites you have visited today (make a 

screenshot). Delete the bookmark you created in above step and Clear the browsing history and 

temporary Internet files. 

3.  Visit Ошибка! Недопустимый объект гиперссылки.ofind out the weather for your 

location (make a screenshot). Again go to your default home page and use the back button to 

return to the weather site. Set a bookmark for this page. Next create a folder called Weather and 

move the bookmark you just created into that folder. Delete the weather folder. 

4.  Go to www.yahoo.com and go to the News category and browse the headlines (make a 

screenshot). Then use the Back button to return to the main Yahoo page. Search for cars in the 

Video search category. 

5.  Go to www.bbc.co.uk and look for all occurrences of the word news on the page. Find a link 

to world news. Use it to browse some international news items (make a screenshot). 

6. Go to www.mapquest.com. Enter your country and get the map for the area you live (make a 

screenshot). Right-click on the map. Save the map to a location on your computer with the name 

My Home.  

7. Go to http://egov.kz/cms/ru and choose the English language (make a screenshot). Browse the 

different sections of the website. Click the Tourism and Sports section, find the address of 

Embassy of the RK in the Republic of India(make a screenshot). 

8. Go to a search engine in your web browser. Search for images of cars. Copy on of the pictures 

found into a Word document and save it, calling it My Car. 

9.  Go to your home page and use the Search Bar to look for News. View one of the sites that are 

returned. Then use the hyperlinks on the site to view some of the current top stories. Again use 

Back button to return to the search engine. Find information on flights to Kazakhstan(make a 

screenshot). Clear your web browser’s History. 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Computer based teaching. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

http://www.amazon.co.uk/
http://www.wikipedia.org/
http://www.yahoo.com/
http://www.bbc.co.uk/
http://www.mapquest.com/
http://egov.kz/cms/ru
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discipline: individual task, oral survey  

7. References 

1.June J. Parsons and Dan Oja, New Perspectives on Computer Concepts 16th Edition - 

Comprehensive, Thomson Course Technology, a division of Thomson Learning, Inc Cambridge, 

MA, COPYRIGHT © 2014. 

2.Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technologies. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p., 

ISBN 978-601-7911-03-4 (A textbook in English with the stamp of the Ministry of Education and 

Science of the Republic of Kazakhstan)  

8. Control questions: 

1. Try to answer the following questions using an Internet search engine. 

2. Who is the first computer programmer? 

3. What was the name the first computer? 

4.           Who is the founder of the company “Apple”? 

 

Class 11 

 

4. The theme: Creation of video files 

5. The goal: The aim of this lesson is to teach students the basics of creating video clips for various 

purposes and publishing the finished video on their own YouTube channels. 

6. The learning objective: Having studied this lesson the student will be able to:  

- list several software used to make video; 

- make his own video; 

- understand some of the elements that are necessary to create quality products; 

- publish a video project. 

4. Key questions of the theme: 

1. How to install free video editing software? 

2. How to make educational and scholarly videos with screen capture software? 

3. How to cut out video fragments? 

4. How to change video format? 

5. How to make a promo video or music video? 

6. How to create YouTube channel for personal use? 

Tasks 

1. Install the following free video editing software on your  computer:  (10-20) 

- Bandicam   is a screen capture software  https://www.bandicam.com/ru/ 

- Avidemux is a video editor designed for simple cutting, filtering and encoding tasks 

http://fixounet.free.fr/avidemux/ 

- VideoPad is a fully featured video editor for creating professional quality videos 

https://www.nchsoftware.com/videopad/ru/index.html  (you can use this video 

https://drive.google.com/file/d/1hkV6K6xyl2tUWohck31Hdom6q8mstjFI/view?usp=sharing ) 

or Movavi  is a fully featured video editor for creating professional quality videos   

https://www.movavi.ru/ 

2. Using Bandicam screen capture software create a 2 minute (or less) educational video.   Record 

sound, add webcam overlay, academy logo and mouse  pointer. (10-20) 

(Instruction here https://www.bandicam.com/support/settings/video/) 

Choose one of the themes below or create your own: 

- How to attach a completed task in Platonus and send it to the teacher; 

- How to create a diagram in MS Excel; 

https://www.bandicam.com/ru/
http://fixounet.free.fr/avidemux/
https://www.nchsoftware.com/videopad/ru/index.html
https://drive.google.com/file/d/1hkV6K6xyl2tUWohck31Hdom6q8mstjFI/view?usp=sharing
https://www.movavi.ru/
https://www.bandicam.com/support/settings/video/
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- How to download a video from YouTube; 

- How to insert a hyperlink in MS PowerPoint; 

- How to export a file to the cloud storage and share a link; 

- How to create a google account; 

- How to create a YouTube channel for personal use. 

3. Using the video editor Avidemux cut out your favorite fragments from 2-3 movies or cartoons and 

then combine them together to make a video collage.       (10-20) 

4. Using the video editor VideoPad or Movavi  to create a promo or music video with an 

introduction, main part and conclusion. Add text, transitions, special effects.    (10-20) 

Choose one of the themes below or create your own: 

- The role of ICT in different sectors of modern society; 

- Application of ICT in medicine and pharmacy; 

- Cybersecurity; 

- Multimedia; 

- Cloud technologies; 

- South Kazakhstan Medical Academy; 

- National holidays in Kazakhstan; 

- Animals included in the Red Book of Kazakhstan. 

5. Create your own YouTube channel, export completed videos and share links with teacher.                                                                                        

(10-20) 

(You can use this video https://drive.google.com/file/d/1lByMUv_THEsQhVWWUZh10WvRk 

AMW6sTM/view?usp=sharing) 

5. The main forms / methods / technology of training to achieve the final learning outcomes discipline: 

Computer based teaching. 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey  

7. References 

1.June J. Parsons and Dan Oja, New Perspectives on Computer Concepts 16th Edition - 

Comprehensive, Thomson Course Technology, a division of Thomson Learning, Inc Cambridge, 

MA, COPYRIGHT © 2014. 

2.Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

3.Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technologies. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p.,  

8. Control questions 

1. How to add a logo to video in the Bandicam screen capture software? 

2. How to customize the mouse pointer in the Bandicam screen capture software? 

3. How to add webcam overlay in the Bandicam screen capture software? 

4. What other screen capture software do you know? 

5. What are the essential functionalities of Avidemux video editor? 

6. How to convert a video file in Avidemux  video editor? 

7. How to use text effects in VideoPad video editor? 

8. How to add sound effects in VideoPad video editor? 

9. How to create a YouTube channel for personal use and export a file and share a link? 

 

Class 12 

 

1. The theme: Operation with Smart-applications: Smart TV, Smart Hub, etc.  

2. The goal: The aim of this lesson is to teach students the basics of creating project skills by working 

with Google Slides. 

https://drive.google.com/file/d/1lByMUv_THEsQhVWWUZh10WvRk%20AMW6sTM/view?usp=sharing
https://drive.google.com/file/d/1lByMUv_THEsQhVWWUZh10WvRk%20AMW6sTM/view?usp=sharing
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3. The learning objective: The student will be able to: 

- use Google Slides; 

- find out what green technologies are in ICT.  

4. Key questions of the theme: 

1. What is Google Slides? 

2. How to create a Google Slides presentation? 

3. What templates can be used to create educational presentations? 

4. How students can use Google Slides in the class? 

Tasks 

Read the brief theory: https://www.google.kz/intl/ru/slides/about/  

2. Open your Google account and create the presentation for following themes: 

2.1 SMART technology 

2.2 Types of SMART technology  

2.3 SMART city 

2.3 SMART home 

2.4 Green technologies in ICT 

2.5 SMART TV 

2.6 SMART Hub 

2.7. Correctly use SMART-services 

(You can use this video https://www.youtube.com/watch?v=KD-naKQisOU) 

3. Insert the images upload the computer. 

4. For insert video use the tool searching the web and insert by URL. Format options: 

- Play automatically 

- For insert only some part this video use the timeline menu 

5. Use the hyperlinks tool to quickly move between slides. 

6. Save your file as presentation type with extension .pptx 

7. Share your link and file via Platonus 

 (You can use this video https://youtu.be/yyFK_tCDBJk ) 

 5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: discussion.  

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey. 

7. References 
1. June J. Parsons and Dan Oja, New Perspectives on Computer Concepts 16th Edition - 

Comprehensive, Thomson Course Technology, a division of Thomson Learning, Inc Cambridge, 

MA, COPYRIGHT © 2014. 

2. Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technology. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p., ISBN 

978-601-7911-03-4 (A textbook in English with the stamp of the Ministry of Education and Science 

of the Republic of Kazakhstan)  

3. Vijay K. Vaishnavi, Vijay K. Vaishnavi, William Kuechler Design Science Research Methods and 

Patterns: Innovating Information and Communication Technology, 2nd Edition 2015 by CRC Press   

4. Hans J Schnoll E-Government: Information, Technology, and Transformation: Information, 

Technology, and Transformation (Routledge, March 12, 2015 - Political Science - 343 p.)  

5. The Millennium Development Goals Report 2015, United Nations, New York, 2015  

8. Control questions: 

1. What is Google Slides? 

2. How to create a Google Slides presentation? 

https://www.google.kz/intl/ru/slides/about/
https://www.youtube.com/watch?v=KD-naKQisOU
https://youtu.be/yyFK_tCDBJk
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3. What templates can be used to create educational presentations? 

4. How students can use Google Slides in the class? 

 

Class 13 

 

1.The theme: Operations with services on the website of the electronic government 

2.The goal: This lesson introduces students to the services they can obtain from the e-government 

website.  

3.The learning objective: Having studied this lesson the student will be able to:  

- obtain his personal digital signature;  

- use the services of the e-government website. 

4.Key questions of the theme: 
1.Electronic digital signature. 

2.The services of the e-government website. 

Tasks 

You have to obtain digital signature keys of National Certification Authority of the Republic of 

Kazakhstan via remote identification.                         (50) 

Step-by-step instruction:  

1. On the homepage of e-Gov Portal (Egov.kz) click “Obtain digital signature remotely” button.  

2. The system will check whether your personal computer has an installed webcamera. Click “Allow” 

in pop-up window.  

 
3. Next, indicate your IIN so that the system could check whether your phone number is 

registered in Mobile Citizens Database (hereinafter: MCD). 

 

 

https://egov.kz/
https://egov.kz/services/Remote.EDS/#/declaration/0//
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4. In case if check has been successful, indicate SMS-code (one-time password) sent from 

1414 to a phone number registered in MCD*. 

 
*Note! In case if you are not registered in Mobile Citizens Database (hereinafter: MCD) or 

you haven`t received a one-time password, the system will offer you to register/re-register your phone 

number pursuant to the clause 5 of the guidance.  

5. *Registration/re-registration of phone number in MCD (if required): Click on virtual 

assistant Kenes located on the right lower side of the webpage and select a language. 

 

Afterwards, click  icon in the lower panel of the assistant and then click “Video 

Call” button. 
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After the start of video call, an Operator will ask you to show your national ID, dictate your 

IIN, phone number and SMS-code. After successful registration in MCD, refresh the Portal webpage 

and fill in your IIN once more as well as one-time password pursuant to steps indicated in caluses 

2,3.  

6. The system will check whether NCALayer is installed/ran on your personal computer*.  

*In case if NCALayer is not installed, the system will offer to download a setup file for 

NCALayer software. User manual on how to install NCALayer is available on the website of National 

Certification Authority of the Republic of Kazakhstan (hereinafter: NCA of RoK) by the following 

link: http://www.pki.gov.kz/nl_ru . 

 
7. After NCALayer is installed, click “Go to obtainment of digital signature” button. 

 

http://www.pki.gov.kz/nl_ru
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8. Remote identification page will open where you need to fill in your phone number 

registered in MCD and SMS-code. 

 
9. After you filled in an SMS-code you need to verify your identity (create Digital ID). To do 

this, click “Start” button. 

 
10. A window will appear where you can make a selfie. Locate your face in the center of the 

screen and click photo icon. 

 
11. To save a photo, click “Send” button or “Try again”, if a photo is not good. 
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12. Then, click “Continue” button to undergo video identification. 

 

 
13. A window for video identification will open and you need to click “Start” button. 
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14. The process of video identification will start. You should follow a set of 

recommendations regarding location of your face and motions. After successful video 

identification, you need to set a PIN-code for further access to account by clicking “Set PINcode” 

button. 

 
Then add an identification document by making photograph of it or by downloading it as a 

file. 

 
15. If you select “Make a photo” function, then you need to click “Start” button and make 

photograph from both sides separately. 
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16. Locate a front side of your document and then reverse side to fit in a frame and click photo 

icon, then click “Send” button. 

 
17. After you saved photographs, you need to check and verify recognized data from 

national ID and click “Send” button. 
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18. The system will check whether your selfie and data from national ID correspond to data 

from the national database of individuals: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

19. After a document is checked you will receive an SMS notification. In “Documents” section 

or on https://did.gov.kz/documents  webpage you need to open a notification by clicking “View” 

button. 

 
20. The system will request access to your data and national ID to transfer it to NCA of RoK 

service and generate request for obtainment of digital sifgmature keys. Click “Continue” button to 

continue. 

 

*If check is successful, a window will 
appear to access personal account. 

 

*In case if data won`t correspond then 
a window will appear with notificaion 

that your document is sent to an 
operator for check (moderation). 

 

https://did.gov.kz/documents
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21. Then, fill in a PIN-code set earlier. 

 
22. The NCA of RoK page will open. Familiarize with User Agreement and click “Verify” 

button. 

 
23. On application form you can indicate your e-mail for further obtainment of notifications 

regarding the status of digital sifgnature keys. When selecting a storage type for keys select “Personal 

computer”. 



 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.72 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

 
24. Then indicate a path to keys storage so that digital signature keys can be saved (select 

folder) and click “Open” button. 
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25. Click “Submit a request” button. 

 
26. Click “Refresh” button. 

 
27. Create and fill in a password for digital signature keys that would correspond to 

rrquire,ents and click “Download certificates” button. 
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28. A window will appear with notification on successful obtainment of digital signature keys. 

 
The procedure of digital signature keys obtainment has been completed. Digital signature keys are 

saved to a folder which you indicated in step 24. 

Take some screenshots that illustrate your work and identify you. Insert them into the MS Word 

document. 

6. You have to obtain a certificate from anti-tuberculosis organization.                (10) 

7. You have to obtain a certificate from a narcological organization.                    (10) 

8. You have to obtain a certificate from a neuropsychiatric organization.             (10) 

9. You have to obtain a certificate on existence or absence of conviction record. (10) 

10. You have to check your tax debt.                                                                       (10) 

Add screenshots of certificates  to the MS Word document and send via Platonus. 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: computer based teaching 

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task 

7. References 
1. June J. Parsons and Dan Oja, New Perspectives on Computer Concepts 16th Edition - 

Comprehensive, Thomson Course Technology, a division of Thomson Learning, Inc Cambridge, 

MA, COPYRIGHT © 2014. 

2. Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technology. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p., ISBN 

978-601-7911-03-4 (A textbook in English with the stamp of the Ministry of Education and Science 

of the Republic of Kazakhstan)  

3. Vijay K. Vaishnavi, Vijay K. Vaishnavi, William Kuechler Design Science Research Methods and 

Patterns: Innovating Information and Communication Technology, 2nd Edition 2015 by CRC Press   

4. Hans J Schnoll E-Government: Information, Technology, and Transformation: Information, 

Technology, and Transformation (Routledge, March 12, 2015 - Political Science - 343 p.)  

5. The Millennium Development Goals Report 2015, United Nations, New York, 2015  

8.Control questions 

1. What is e-government? 

2. What important stages can be identified in the creation and development of the electronic 

government of the Republic of Kazakhstan? 

3. What online services  you can obtain on the egov.kz website? 

 

Class 14 

 

1. The theme: Development of structure and the maintenance of a lesson in the environment of 

remote learning 

2. The goal: The aim of this lesson is to introduce students to the concept of e-learning, the 

advantages and disadvantages of e-learning, and the opportunities they can implement on 
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educational platforms. 

3. The learning objective: Having studied this lesson the student will be able to:  

-   understand the basic concepts of e-learning; 

- list several educational platforms that may be useful for self-education; 

- register on the educational platform; 

- create word clouds using an online service. 

5. Key questions of the theme: 

1. What is e-learning explain with example? 

2. What are the types of e-learning? 

3. What are the advantages and disadvantages of e-learning? 

4. What are some e-learning tools? 

5. What educational platforms do you know? 

Tasks 

11. Create an “E-learning” word cloud using an online word cloud art creator  https://wordart.com/.  

Take a screenshot of the  word cloud, save as an image and send to Platonus.       (10-20) 

 

 
 

12. List the advantages and disadvantages of a “E-learning” using fishbone diagram.                                                                                                       

(10-20) 

 

https://wordart.com/
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13. List the Must-Have Features of an Online Educational platform and give a brief description. The first 

block is filled in as a sample.                               (10-20) 

 
14. Find information about TOP-5 Resources for Self-education, which would contain courses in 

Medicine and Pharmacy. Give them a brief description. (10-20) 

 
15. Using the link  

Coursera | Build Skills with Online Courses from Top Institutions 

go to the Coursera educational platform, register, choose a free course that you like, start learning.  

Using the Bandicam screen capture software create an educational video about this platform. Record 

sound, add webcam overlay, academy logo and mouse  pointer.   Create your own YouTube 

channel, export completed videos and share links with teacher. (10-20) 

https://www.coursera.org/
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(Instruction here https://www.bandicam.com/support/settings/video/) 

16. Take part in the distance learning survey for students by following the link 

https://docs.google.com/forms/d/e/1FAIpQLSe9cLQgmZgEBiahhz4Po3zUHuojih69k56ZOY7lCbk

SRmX0aQ/viewform?usp=sf_link 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: discussion.  

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey. 

7. References 
1. June J. Parsons and Dan Oja, New Perspectives on Computer Concepts 16th Edition - 

Comprehensive, Thomson Course Technology, a division of Thomson Learning, Inc Cambridge, 

MA, COPYRIGHT © 2014. 

2. Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technology. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p., 

ISBN 978-601-7911-03-4 (A textbook in English with the stamp of the Ministry of Education and 

Science of the Republic of Kazakhstan)  

3. Vijay K. Vaishnavi, Vijay K. Vaishnavi, William Kuechler Design Science Research Methods and 

Patterns: Innovating Information and Communication Technology, 2nd Edition 2015 by CRC 

Press   

4. Hans J Schnoll E-Government: Information, Technology, and Transformation: Information, 

Technology, and Transformation (Routledge, March 12, 2015 - Political Science - 343 p.)  

5. The Millennium Development Goals Report 2015, United Nations, New York, 2015  

8. Control questions 

1. List the advantages and disadvantages of a “E-learning”. 

2. List the Must-Have Features of an Online Educational platform. 

3. List some e-learning tools. 

4. Describe TOP-5 Resources for Self-education 

 

Class 15 

 

1. The theme: Installation and use of application programs in the professional sphere. Working in 

the Matlab environment for scientific and technical computing. Working with the Matlab toolboxes 

for applied problem solving. 

2. The goal: The aims of this class are  to provide a knowledge and skills in performing calculations 

on the enter data using formulas in STATISTICA 10, to give  the basic ideas about charts. 

3. The learning objective: Having studied this class the student will be able to: 

- insert formulas by using arithmetic operations with contents of the cells; 

- format the cells and the contents; 

- create charts for given data set; 

- customize the features of charts. 

4 Key questions of the theme: 

1. What are the advantages of using computerized Spreadsheets? 

2. What kind of documents you can create in the STATISTICA? Which extensions are these 

documents? 

3. What operations can be performed with the columns and rows of a spreadsheet? 

4. How to create a formulas in the spreadsheet? 

5. How to create a charts in the STATISTICA? 

6. What kind of charts in the STATISTICA do you know? 

https://www.bandicam.com/support/settings/video/
https://docs.google.com/forms/d/e/1FAIpQLSe9cLQgmZgEBiahhz4Po3zUHuojih69k56ZOY7lCbkSRmX0aQ/viewform?usp=sf_link
https://docs.google.com/forms/d/e/1FAIpQLSe9cLQgmZgEBiahhz4Po3zUHuojih69k56ZOY7lCbkSRmX0aQ/viewform?usp=sf_link


 

Department of  “Medical Biophysics and Information Technology” 044 -35/11 (   ) 

p.78 out of 88 Guidelines for practical clases on the subject “Information communication technology” 

 

1. Practical task. Spreadsheet formula.                                                                                     (5-10) 

1. Start STATISTICA 10. 

2. Create a new document: Home →File →New→Spreadsheet. 

3. Create the table (6 variables by 15 cases). 

4. Type the titleof the table “Blood pressure” in the white box below the line: «Data: Spreadsheet1 

(6v by 15c)» (figure 1) . 

5. Double-click on the Var1. The Variable specification dialog will be displayed.In the Name field 

type “The upper limit of blood pressure before taking the drug”. Click  the  button to move to 

the next column. In the Name fieldtype “The upper limit of blood pressure after taking the drug”. 

Click the  button. In the Name field type “Difference”. Click the  button. In the Name 

field type “The lower limit of blood pressure before taking the drug”. Click the  button. In the 

Name fieldtype “The lower limit of blood pressure after taking the drug”. Click the  button. In 

the Name fieldtype “Difference” (figure 1). 

6. Enter the data shown in figure 1.  

 
Figure 1. 

 

7. Double-click on the variable name Difference in the third column.In the Long name fieldat 

the bottom of the  dialog, enter the formula: = v2-v1 and click the OK button(figure 2). 
 

 
Figure 2. 

A dialog will be displayed that informs you whether the formula is formally correct. Click the Yes 

button to proceed. 

Double-click on the variable name Difference in the sixth column. In the Long name fieldenter the 

formula: = v5-v4 and click the OK button. Click the Yes button to proceed. 

8. Save the file: Home→File→Save→Save As“Blood pressure.sta”. 

2. Practical task. Spreadsheet formula.                                                                                  (5-10)                       

1. Start STATISTICA 10. 
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2. Open the Adstudy.sta data file.  

3. Create a new variable that is the mean of variables 3 through 25. Double‐

click on the first blank variable header (after variable 25). 

4. The Add Cases and/or Variables dialog will be displayed. Click the OK button to accept the  defa

ult, which is to add one variable.  

5. The Variable specification dialog for the new variable will be displayed. In the  Display format gr

oup, select Number. In the Long name field at the bottom of the  dialog, enter: =mean(v3:v25) 

(figure 3).  

 
Figure 3.  

 

Click the OK button. Click the Yes button to proceed. The new variable is now filled with the mean 

of variables 3 through 25 for each case.  

6. Сlose the Adstudy.sta  file, doesn’t save changes. 

3. Practical task. Batch formulas.                                                                                                                    

1. Start STATISTICA 10. 

2. Open the Characteristics.sta data file. This data file contains information about patients in a study. 

For this example  1) calculate patient Body Mass Index (BMI) and 2) convert height to centimeters 

(cm), and add these two variables to the data set. 

3. On the Data tab, in the Transformations group, click Transforms to display the Batch 

Transformation Formulas dialog (figure 4). 

 

 
Figure 4. 
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4. In the Formulas field, enter the list of transformation formulas to be applied to the active data 

spreadsheet:  

BMI=('weight (lb)' / 'Height (in)' **2)*703 

'Height (cm)' = 'height (in)' *2.54  

Separate each transformation formula by a return (press Enter on keyboard) (figure 5). 

 
Figure 5. 

 

5. Click the OK button in the Batch Transformation Formulas dialog. The Add New Variables? will 

be displayed; click the Yes button to add the two new variables to the Characteristics.sta data file. A 

message will be displayed to information whether the expressions you entered in the Batch 

Transformation Formulas dialog are correct. If they are OK, click Yes to proceed. STATISTICA 

calculates the formulas and adds the two variables, BMI and Height (cm), to the spreadsheet. 

6. Сlose the Characteristics.sta file, doesn’t save changes. 

4. Practical task. Input data directly from Excel.                                                                        

1. Start STATISTICA 10. 

2. On the STATISTICA Home tab, in the File group, click the Open arrow and select Open Examp

les from the drop‐down menu to display the Open a STATISTICA Data  File dialog. 

3. From the Files of type drop-down list at the bottom of the dialog, select Excel Files (*.xls, *xlsx, 

*xlsm). Double-click the Datasets folder, and then select the Weather report data file, which is 

an Excel file. Click the Open, and the Opening file dialog will be displayed.  

4. Click the Open as an Excel Workbook button, and the Excel file will be displayed. Note that when 

an Excel worksheet is opened in STATISTICA, the Excel and STATISTICA menus merge, 

enabling you to access key functionality for both applications. 

5. From the Statistics menu, select Basic Statistics/Tables.The Select Excel Range for the Analysis 

dialog will be displayed. Click the OK button in the Select Excel Range for the Analysis dialog to 

accept the defaults; the dialog will close, and the Review/Edit Column Types dialog will be 

displayed. Click OK button.  

6. Startup Panel is displayed. Select Descriptive Statistics analysis.Click OK button. The analysis 

specification dialog will be displayed (figure 6). 
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Figure 6. 

 

7.Click the Variables button, and in the variable selection dialog, select Temperature.Click OK in the 

variable selection dialog to return to the Descriptive Statisticsdialog. 

8.Click Summary button. The result table will be displayed (figure 7). 

 

 
Figure 7. 

 

9. Save the file as Weather report.stw. 

 

6. Practical task. Filter Duplicate Cases.                                                                                      

1. Start STATISTICA 10. 

2. Open the Duplicates.sta data file. Notice that is 10v by 60c (10 variables by 60 cases). 

3. On the Data tab, in the Transformations group, click Filter/Record menu, select Filter Duplicate 

Cases to display the Filter Duplicate Cases dialog. In the Input group box, the Variables option is 

used to specify the basis of distinction for duplicates. Click the Variables button, and in the variable 

selection dialog, select Respondent so that all respondents will be checked for duplicates. Click OK 

in the variable selection dialog to return to the Filter Duplicate Cases dialog (figure 8). 
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Figure 8. 

 

4. In the Input group box, verify that all cases are selected. 

5. In the Output group box, verify that all variables are selected. 

6. Verify that the Create new spreadsheet check box is selected (the default), and select the Create 

duplicates spreadsheet check box. 

7. Leave the last two options at their defaults: the Preserve order check box is cleared, and the Copy 

formatting check box is selected. Click OK.  

8. Two new spreadsheets will be generated. One of the spreadsheets is 10v by 51c and contains the 

respondents from the original spreadsheet excluding the duplications. The other spreadsheet is 10v 

by 9c and contains the duplicate respondents that were extracted from the original spreadsheet. 

9. Close the file, doesn’t save changes. 

7. Practical task.Creating Subsets.                                                                                                                              

1. Start STATISTICA 10. 

2. Open Boston2.sta data file. This data set contains over a thousand cases. We want to extract housing 

tracts with low median prices. 

3. Select the Data tab, and in the Manage group, click Subset to display the Create a Subset dialog 

(figure 9). 

 

 
Figure 9. 

 

3. Click the Cases button to display the Spreadsheet Case Selection Conditions dialog, which contains 

options to create conditions to define the selection of cases to be considered for the sample. 
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4. Select the Enable Selection Conditions check box to activate the options, and then select the 

Specific, selected by option button in the Includecases group box to specify which cases to include in 

the analysis. Type v1=’LOW’ in the Expression text box. 

5. Click the OK button to set the selection conditions and return to the Create a Subset dialog, and 

click the OK button in this dialog to create the new spreadsheet. The resultant spreadsheet contains 

334 cases and all 15 variables from the original spreadsheet. For the Price variable, all cases have a 

value of LOW.  

6. Close the file, doesn’t save changes. 

8. Practical task. Creating charts.                                                                                                                                                    

1. Start STATISTICA 10. 

2.Create a new document: Home →File →New→Spreadsheet. 

3. Create the table (1v by 7c). 

4. Type the titleof the table “Mortality from cancer among the population of the CIS countries, 2013 

y.” 

5. Rename the rows in the CIS countries names. Enter the data, as shown in figure 10. 

 

 
Figure 10. 

 

6. Click the Graphs tab on the Ribbon. Click the 2D button in the More… group, and select Pie Charts 

from the drop-down list.  

7. The Pie Charts dialog will be displayed, click Advanced tab.  

8. Click the Variables buttonand in the variable selection dialog, selectname of the variable. Click 

OK in the variable selection dialog to return to the Pie Charts dialog. 

9. ChoosethePie Charts – Valuesgraph type. 

10. Click the Spreadsheet button and choose Case names. 

11.Choose Text and Percent in the Pie legend window.  

12. Click OK button. The Pie Chart will appear (figure 11). 

 

 
Figure 11. 
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13. Double click on the Pie Chart. Change the Outside Background color, Inside Background color, 

Font size of title, Explode distance (figure 12). 

 
Figure 12. 

 

14. Click the Graphs tab on the Ribbon. Click the 2D button in the More… group, and select 

Bar/Column Plots from the drop-down list.  

15. The Bar/Column Plotsdialog will be displayed, click Advanced tab. 

16. Click the Variables button,and in the variable selection dialog, selectname of the variable. Click 

OK in the variable selection dialog to return to the Bar/Column Plotsdialog. 

17.Choosethe  Regulargraph type.Choose the Vertical orientation.Click OK button.The Bar/Column 

Plot will appear (figure 13). 

 
Figure 13. 

18. Save the workbook: Home→File→Save→Save As“Chart.stw”. 

9. Practical task. Creating charts.                                                                                              

Using the data given below create the Bar/Column Plot “Number of hospitals in the Republic of 

Kazakhstan, 2015 y.” 

Republic of Kazakhstan 901 

Akmolinskaya 38 

Aktyubinskaya 47 

Almatinskaya 86 

Atyrauskaya 36 

East Kazakhstan 88 

Zhambylskaya 57 

West Kazakhstan 37 

Karagandinskaya 83 

Kostanayskaya 51 

Kyzylordinskaya 50 

Mangistauskaya 29 

Pavlodarskaya 42 
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North Kazakhstan 28 

South Kazakhstan 122 

Astana 31 

Almaty 76 

 

10. Practical task. Creating charts.                                                                                                              

Using the data given below create the Pie Chart“Sickness rate of active tuberculosis on age groups, 

2015 y.” 

0-14 15-17 18-34 35-54 55-64 65 and elder 

4 5 44 32 9 5 

 

5. The main forms / methods / technology of training to achieve the final learning outcomes 

discipline: Computer based teaching.  

6. Types of control for assessing the level of achievement of the final learning outcomes of the 

discipline: individual task, oral survey.  

7. References 

1. June J. Parsons and Dan Oja, New Perspectives on Computer Concepts 16th Edition - 

Comprehensive, Thomson Course Technology, a division of Thomson Learning, Inc Cambridge, 

MA, COPYRIGHT © 2014. 

2. Shynybekov D.A., Uskenbayeva R.K., Serbin V.V., Duzbayev N.T., Moldagulova A.N., 

Duisebekova K.S., Satybaldiyeva R.Z., Hasanova G.I., Urmashev B.A. Information and 

communication technology. Textbook: in 2 parts. Part 1, 1st ed. - Almaty: IITU, 2017. - 588 p., ISBN 

978-601-7911-03-4 (A textbook in English with the stamp of the Ministry of Education and Science 

of the Republic of Kazakhstan)  

3. Vijay K. Vaishnavi, Vijay K. Vaishnavi, William Kuechler Design Science Research Methods and 

Patterns: Innovating Information and Communication Technology, 2nd Edition 2015 by CRC Press.   

8. Control questions: 

1.What are the advantages of using computerized Spreadsheets? 

2.What kind of documents you can create in the STATISTICA? Which extensions are these 

documents? 

3.What operations can be performed with the columns and rows of a spreadsheet? 

4.How to create a formulas in the spreadsheet? 

5.How to create a charts in the STATISTICA? 

6.What kind of charts in the STATISTICA do you know? 
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